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Chapter 1: Introduction
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ge 9 (following this introduction). 

ace, as well as how to get the most out of 
nality compared with the much more 
 the CoViz 4D Viewer. This documenta-
wer.

iewer are available at the end of the 

ncrypted 3D models (known as encrypted 
rtical and non-vertical fault files, polygon 
roviding the user with numerous display, 
mmand menu, the model and ASCII data, 
er, graphic aspects of the display can be 
ges of the X, Y, Z, and P values displayed, 
nus are available that can be used to 
le keystrokes representing commands, are 

he user to visualize the data prior to 
 or property. Beyond the basic capabilities 
ools include:

ulating a model

sed on the model

 and interpretation verification
8 EarthVision 8.0 2

The Demo 3D Viewer is used to view and manipulate one 3D 
file) and, after an encrypted faces file is loaded, scattered da
binary well data, and image registration files can be loaded,
the faces file or are designated as “unknown” in their respectiv
data types are shown in the color figure pages, starting on pa

This document discusses how to use the Demo 3D Viewer interf
the Demo 3D Viewer. The Demo 3D Viewer has limited functio
capable EarthVision 3D Viewer, the WellArchitect Viewer, and
tion covers only the functions available in the Demo 3D Vie

Appendices and a glossary of terms specific to the Demo 3D V
Demo 3D Viewer document.

The Demo 3D Viewer:
3D Display, Visualization, and Editing

The Demo 3D Viewer interactively displays and manipulates e
faces files), scattered data files (.dat, .pdat, and .path files), ve
files (both .vply and .ply files), , and image registration files, p
editing, and capture functions. The initial display includes a co
and a key, known as the color key. Once in the Demo 3D View
altered, such as the view angle, vertical exaggeration, and ran
and fault files or polygon files can be displayed. A host of me
obtain a multitude of different images. Hot keys, which are sing
also available for nearly every menu command.

These capabilities offer powerful tools for analysis, enabling t
modeling, as well as view the final modeled surface, structures,
of rotation and slicing, some of the more powerful analytical t

 Viewing and editing scattered data files prior to calc

 Editing or creating additional scattered data files ba

 Displaying seismic data along with models for model

 Saving screen displays
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e view of a two-layer model with an
, well tube, and well data displayed,
 an image overlay
3D Viewer EarthVision 8.0

Chair mod
isosurface
along with

Faulted 3D property model
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EarthVision structural model in 
thrusted terrain with well data 
and surface imagery.

Subsurface data courtesy of 
Marathon Oil Company
10 EarthVision 8.0 2

EarthVision structural and cellular 
model with well data for a North Sea 
salt dome.
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mplified 3D Extensional model 
ilt in EarthVision.
3D Viewer EarthVision 8.0

Si
bu

Upscaled cellular property model 
based on EarthVision property/
structural model.
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a faulted turbitite channel 
uilt in EarthVision, 
d with well and cellular 
12 EarthVision 8.0 2

North Se
model b
displaye
data
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EarthVision structural models 
displayed in the Demo 3D Viewer.
3D Viewer EarthVision 8.0
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Teapot Dome oil field, 
Wyoming, displayed in 
the Demo 3D Viewer.

Data provided courtesy 
of Rocky Mountain 
Oilfield Testing and the 
US Department of 
Energy.
14 EarthVision 8.0 2

Acid Neutralization Potential 
Model.
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Color-filled contour map of elevations
displayed, along with data, on top of a

 faulted zone

Fault surfaces displayed with data
color-coded by fault block
3D Viewer EarthVision 8.0

single
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16 EarthVision 8.0 2

Full 20-layer, faulted model displayed, with
data, with chair mode off in one zone
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Brisbane Landfill:
Four-layer model of
deformed, interfingered,
lithologic units
3D Viewer EarthVision 8.0

Processing by Queensland Supercomputing Laboratories of
CSIRO. The Brisbane Landfill is operated by Pacific Waste
Management. Well tubes are for display purposes only.
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18 EarthVision 8.0 2

Site annotation
displayed above
contaminant plume
and input data
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Chapter 2: Demo 3D Viewer File Types
Most of these files are initially created 
ile types are discussed in the following 

ype used in or created by EarthVision and 
include encrypted faces files, scattered 
d and property data files, well path files, 
s, well target files, image files, cellular 

. These files are created either in the Demo 
 3D Viewer input files are not used to 
urposes: either to be viewed, or in some 
tail next.

rogram. These binary files contain X, Y, 
ng them essentially 3D contour maps. Two 
ed faces files can be sliced at any 
nt) and can be generated by the Geologic 
eration. All encrypted faces file names 
3D Viewer EarthVision 8.0

Several different file types are used in the Demo 3D Viewer. 
elsewhere in EarthVision (e.g., in Faces File Generation). The f
sections.

Input files to the Demo 3D Viewer consist of almost every file t
the other DGI programs, such as WellArchitect. The input files 
data files, 2D grids, 3D grids, surface annotation files, scattere
vertical and non-vertical fault files, vue files, color files, list file
grids, Binary well displays, groups, and attribute surfaces files
3D Viewer, EarthVision, or by using a system editor. The Demo
“calculate” other data files, rather they are used for display p
way determine the view. Each file type is discussed in more de

Encrypted Faces Files (.encn.faces)
Encrypted faces files are supplied with the Demo 3D Viewer p
and Z coordinates for each user-specified isovalue level, maki
types of encrypted faces files exist: sliced and unsliced. Unslic
arbitrary location (refer to the Slice Tab section of this docume
Structure Builder, the WorkFlow Manager, or in Faces File Gen
must end with the suffix .encn.faces.
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Scattered Data, Property Data, and

e displayed and, if desired, edited in the 
ese files could, for example, represent 
oints along lines of any kind, such as well 
ut data prior to gridding, for editing, as a 
r P-field for an entire data set.

data file. The default colors used for each 
 (in order) green, red, blue, orange, 
 through the colors. Z-fields with line IDs or 
en X,Y path, as appropriate. Data editing 
lds are selected.

 is optional. Other optional fields are also 
 names in scattered data, property data, 

ated by setting the Z field units as “downward” 

at do not have one of these “special” names (e.g., 
 and .pdat files, respectively).

s associated with a data location can be posted 
iewer.

e assumed to be located along the same line and 
iewer.

to the previous points in the file. When a line ID is 
ata points are drawn in a default color.

lues are between 1 and 72 (refer to the symcolor 
t to point (when the points have the same line ID), 
olor of the first point in the segment (hence, a line 
20 EarthVision 8.0 2

Well Path Files (.dat, .pdat, .path)
ASCII scattered data, property data, and well path files can b
Demo 3D Viewer either with or without a faces or grid file. Th
either scattered data that were used as input to gridding or p
bores or seismic lines. These data files can be used to view inp
reference file unrelated to the faces file, and to view any Z- o

Multiple Z-fields can be selected when displaying a scattered 
Z-field differ: yellow is used for the first Z-field selected, then
magenta, brown, and white for subsequent fields, cycling back
well IDs are drawn with lines connecting each point along a giv
and data animation cannot be performed when multiple Z-fie

The file must, at minimum, contain an X, Y, and Z field. A P-field
available. The Demo 3D Viewer recognizes the following field
and well path files: 

Field Name Definition

x The spatial X location of the data point.

y The spatial Y location of the data point.

z= The spatial Z location of the data point.

Note:  Z by default increases upward; depth field values must be indic
(e.g., “feet downward”)

p= The property value at the X,Y,Z location.

=   In addition to the Z-field and P-field names (Z and P), any fields th
X, Y, feature, etc.) are considered to be potential Z- or P-fields (in .dat

comment A comment field is available so that text string
when querying a data point in the Demo 3D V

lineid, wellid Data points with the same value in this field ar
will be connected by a line in the Demo 3D V

Note:   If a line ID field is blank, then the points are drawn connected 
present and a line color field is not specified, the lines connecting the d

linecol The color with which to draw the line; valid va
discussion below). If this value varies from poin
the line connecting the points is drawn in the c
may be drawn in multiple colors).
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Field Name Definition

have a radius field can have a tube of varying 
rawn along the length of the line; this tube is 
n on the Render tab.

cation; valid values are from 0 to 90; data 
imuth values have a dipping disk displayed at that 

alid values are from 0 to 360; data locations that 
ave a dipping disk displayed at that location 

ters), such as “ABC Fault” or “Top Zone”; points 
ng the same feature (such as a fault plane, or 
 conjunction with featurecol.

rawn in the same color (as defined by the feature 
feature or fault plane (this number could be used 
an be used in conjunction with featureid.

n; valid values are

thquake foci symbol*

UNGE, PAZIM, NPLUNGE, and NAZIM; otherwise, 

DIPMAX, DIPAZMMAX, AXISLENMIN, AXISLENMAX, 
be is drawn.

DIPMAX, DIPAZMMAX, AXISLENMIN, AXISLENMID, 
is drawn.

If DIP and/or DIPAZM are not specified, 0.0 
, symbol 10 is assumed, unless another symbol 

h the symbol is drawn; the default is 1.0; any 

bol or bi-colored sphere (symbol 7), this field can 
lf the width of the symbol in XY (the effective 
10), it specifies the radius of the disk (regardless 
 scale units.

the Z-exaggeration is increased or decreased, the 
of the symbol will increase or decrease, respec-
intains a proportional size to the XY width.
3D Viewer EarthVision 8.0

radius Data points with the same line or well ID that 
radius (as defined by the values in this field) d
displayed by selecting the Tube Display optio

dip The value of the measured dip at that data lo
locations that have associated dip and dip az
location based on the values given.

dipazm The compass direction or azimuth of the dip; v
have associated dip and dip azimuth values h
based on the values given.

featureid An alphanumeric description (up to 20 charac
with the same value are considered to be alo
located within the same zone); can be used in

featurecol Points that have the same value (1–64) are d
color table) and are located along the same 
to represent any kind of continuous feature); c

symbol The symbol to draw at the data (X,Y,Z) locatio
   1   =   cube [default]
   2   =   cross
   3   =   diamond
   4   =   hourglass
   5   =   column
   6   =   sphere
   7   =   bi-colored sphere or ear
   8   =   elliptic disk**
   9   =   ellipsoid***
  10   =   round disk**** 
  11   =   downward-pointing cone 
  12   =   upward-pointing cone

*    Requires fields TPLUNGE, TAZIM, PPL
the default cube is drawn.

**   Requires fields DIPMIN, DIPAZMMIN, 
DISKTHICKNESS; otherwise, the default cu

***  Requires fields DIPMIN, DIPAZMMIN, 
AXISLENMAX; otherwise, the default cube 

**** Drawn at specified DIP and DIPAZM. 
is assumed; if DIP and DIPAZM are present
value is specified.

symsize Determines the scale factor (or size) with whic
number between 1 and 100 is valid.

symdatasize Although required for the earthquake foci sym
be applied to any symbol type; it specifies ha
“radius”). For the dip/dipazm disks (symbol #
of orientation). The radius is specified in data

This field differs from the symradius in that as 
Z height (as determined by the symdatasize) 
tively; with symradius, the Z height always ma
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Field Name Definition

lf the width of the symbol in XY. For dip/dipazm 
he disk (regardless of orientation). The radius is 

as the Z-exaggeration is increased or decreased, 
ppears to maintain the same proportional size to 

d values are between 1 and 72; the default is 

 solid object (a value of 0; the default) or if it is 

the zone where a data point is located in a corre-
s value is assigned within the EarthVision program.

h the data point is located. This value can be 

a data point is located in a corresponding 
e is assigned within the EarthVision program.

s the current point should be constrained to be 

current point. This field is used in seismic data files.

OL field 7 required):

xis; valid values are 0.0 to 360.0. This field is 

axis; valid values are 0.0 to 360.0. This field is 
22 EarthVision 8.0 2

symradius Similar to symdatasize, the setting specifies ha
disks (symbol #10), it specifies the radius of t
specified in data scale units.

This field differs from the symdatasize in that 
the Z height of the symbol changes so that it a
the XY width.

symcolor The color with which the symbol is drawn; vali
white/black (1).

symtrans Determines whether the symbol is drawn as a
drawn transparent (a value of 1).

zoneid The alphanumeric ID (up to 20 characters) of 
sponding EarthVision encrypted faces file. Thi

zonecol The assigned color (1–72) of the zone in whic
assigned by the user.

faultblock The alphanumeric ID of the fault block where 
encrypted faces file. Like the zone ID, this valu

straight Determines whether the segment that precede
straight (nonzero value) or not (0 or blank).

shotpt The shotpoint ID (up to 20 characters) for the 

Earthquake foci symbol additionally recognized field names (SYMB

tplunge The measured plunge angle of the tensional a
required for symbol 7 to be drawn.

tazim The measured azimuth angle of the tensional 
required for symbol 7 to be drawn.
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Field Name Definition

nal axis; valid values are 0.0 to 360.0. This field 

onal axis; valid values are 0.0 to 360.0. This field 

is, that is, the axis of intersection of the tensional 
 to 360.0. This field is required for symbol 7 to be 

is, that is, the axis of intersection of the tensional 
 to 360.0. This field is required for symbol 7 to be 

symbol or bi-colored sphere, symbol 7. Radius is 
 applied to any symbol type; it specifies half the 
us”). For the dip/dipazm disks (symbol #10), it 
orientation).

drant of the earthquake foci symbol (bi-colored 
 are 1 to 72 (refer to symcolor above for avail-

al quadrant of the earthquake foci symbol (bi-
lid values are 1 to 72 (refer to symcolor above 

 bisecting the tensional and compressional axes on 
not drawn) or 1 (drawn).

 whose normal bisects the tensional and compres-
 values are 0 (not drawn) or 1 (drawn).

ames (SYMBOL field 8 or 9, respectively, 

ple axis of symbols 8 or 9; valid values are 0.0 to 
9 to be drawn.

nciple axis of symbols 8 or 9; valid values are 0.0 
or 9 to be drawn.

ciple axis of symbols 8 or 9; valid values are 0.0 
or 9 to be drawn.
3D Viewer EarthVision 8.0

pplunge The measured plunge angle of the compressio
is required for symbol 7 to be drawn.

pazim The measured azimuth angle of the compressi
is required for symbol 7 to be drawn.

nplunge The measured plunge angle of the neutral ax
and compressional axes; valid values are 0.0
drawn.

nazim The measured azimuth angle of the neutral ax
and compressional axes; valid values are 0.0
drawn.

symdatasize Determines the radius of the earthquake foci 
specified in data scale units. This field can be
width of the symbol in XY (the effective “radi
specifies the radius of the disk (regardless of 

eqtsymcolor The color with which to draw the tensional qua
sphere).The default color is blue; valid values
able colors).

eqpsymcolor The color with which to draw the compression
colored sphere).The default color is yellow; va
for available colors).

eqfltplane1 Toggles whether or not a fault plane is drawn
earthquake foci symbols; valid values are 0 (

eqfltplane2 Toggles whether or not a fault plane is drawn
sional axes on earthquake foci symbols; valid

Elliptical and Ellipsoid disk symbol additionally recognized fields n
required):

dipmin The measured dip angle of the minimum princi
360.0. This field is required for symbols 8 or 

dipazmmin The measured dip azimuth of the minimum pri
to 360.0. This field is required for symbols 8 

dipmax The measured dip angle of the maximum prin
to 360.0. This field is required for symbols 8 
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Field Name Definition

inciple axis of symbols 8 or 9; valid values are 0.0 
or 9 to be drawn.

 principle axis of symbols 8 or 9. Value is speci-
or symbols 8 or 9 to be drawn.

diate principle axis of symbol 8 or 9, an elliptical 
s field is required for symbol 8 or 9 to be drawn.

m principle axis of symbols 8 or 9. Value is speci-
or symbols 8 or 9 to be drawn.

tic disk symbol, in data scale units. This field is 

 vertices (1,2,3) and (2,3,4), which results in a 
s not required, but the symbol is drawn if all 

coordinate surfaces. Specified in data scale units.

ur-coordinate surfaces. Specified in data scale 

-coordinate surfaces. Specified in data scale units.

ur-coordinate surfaces. Specified in data scale 

d.

1

2

3 4
24 EarthVision 8.0 2

dipazmmax The measured dip azimuth of the maximum pr
to 360.0. This field is required for symbols 8 

axislenmin Determines the radius or length of the minimum
fied in data scale units. This field is required f

axislenmid Determines the radius or length of the interme
disk. Value is specified in data scale units. Thi

axislenmax Determines the radius or length of the maximu
fied in data scale units. This field is required f

diskthickness Determines the thickness of symbol 8, the ellip
required for symbol 8 to be drawn.

Four coordinate surface additionally recognized field names

The four-coordinate surface is drawn as two triangles composed of
crease occurring between vertices 2 and 3. A special symbol type i
twelve four-coordinate X,Y,Z values are specified.

fourc_x1
fourc_y1
fourc_z1

Defines the first X, Y, or Z coordinate for four-

fourc_x2
fourc_y2
fourc_z2

Defines the second X, Y, or Z coordinate for fo
units.

fourc_x3
fourc_y3
fourc_z3

Defines the third X, Y, or Z coordinate for four

fourc_x4
fourc_y4
fourc_z4

Defines the fourth X, Y, or Z coordinate for fo
units.

For 3D vector display, fields other than X, Y, and Z must be specifie

z
y

x
➤

➤

➤
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col, the following fields are recognized:

 3D Viewer and generated as output from 

Field Name Definition

 the vector is drawn as a 1-pixel width line with a 
 optionally specified (as a decimal fraction of the 

its) for the tail of the vector.

its) for the head of the vector.

 fraction of total vector length.

racters or less)

xis (clockwise)

r pointing straight down

ta point in the well path and the previous data 

data point in the well path and the previous data 

reciprocal of the dog-leg severity (real)

ngent at the point and the tangent at the previous 

dog-leg angle per a distance, typically 30 meters 

ata point (1) or an interpolated point (0)

int in the well path and the previous data point 

int in the well path and the previous data point 

t in the well path and the previous data point (real)

al to the surface (fault or horizon) it intersects
3D Viewer EarthVision 8.0

For well path files, in addition to X, Y, wellid, symbol, and line

Well interpolation fields; these fields are posted by the Demo
other EarthVision modules.

The user specifies the XYZ coordinates of the vertex head and tail, and
shaded cone for the vector head. The length of the vector head can be
total vector length).

vec_x1
vec_y1
vec_z1

Specifies the XYZ coordinate (in data scale un

vec_x2
vec_y2
vec_z2

Specifies the XYZ coordinate (in data scale un

vec_lenpct Specifies the length of the head as a decimal

TVDSS (required) True vertical depth sub-sea

Commonid An additional unique name or a well (20 cha

MD Distance measured down the well hole

Field Name Definition

AZIMUTH The angle between the well path and the Y-a

INCLINATION The angle between the well path and a vecto

DELTA_AZIMUTH The change in azimuth between the current da
point (real)

DELTA_INCLIN The change in inclination between the current 
point (real)

RADIUS_OF_CURV The radius of curvature is proportional to the 

DOGLEG The dog-leg angle is the angle between the ta
point (real)

DL_SEVERITY Dog-leg severity is the number of degrees of 
or 100 feet (real)

ORIG_PT A flag indicating that the point is an original d

DX The change in X between the current data po
(real)

DY The change in Y between the current data po
(real)

DZ The change in Z between the current data poin

RELATIVE_DIP The angle between the well path and the norm
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For map pin scattered data files, in addition to linecol and symsize, the following fields are required:

 pinhead XYZ, pintail XYZ, linecol, and 

84  2129.195  2862.776  42  3
94  2130.354  2862.905  14  3
05  2131.51   2863.033  42  3
16  2132.658  2863.155  50  3
33  2133.802  2863.284  18  3
55  2134.945  2863.413  34  3
81  2136.086  2863.543  54  3
06  2137.222  2863.672  30  3
32  2138.35   2863.802  30  3
58  2139.478  2863.931  30  3
86  2140.604  2864.059  46  3
19  2141.724  2864.181  26  3

d of the map pin

of the map pin
26 EarthVision 8.0 2

The following is an excerpt from a map pin file, containing the
symsize fields, and as displayed in the Demo 3D Viewer:

1823.64080246  2129.84777321  2867.91188094  1824.2
1826.59916022  2130.19176034  2862.56169894  1826.4
1827.69362346  2132.61883908  2870.96323546  1828.7
1828.40298361  2136.97341611  2868.13705263  1830.9
1833.27348966  2133.56098247  2863.0057749   1833.1
1835.4841066   2134.64259301  2863.86382757  1835.3
1833.96311719  2142.81552756  2866.70277956  1837.5
1841.93802564  2132.46416224  2868.71129038  1839.8
1844.84621671  2132.21678005  2868.85792933  1842.0
1847.66978608  2132.37210862  2867.19089623  1844.2
1845.06103278  2142.76879284  2870.26562681  1846.4
1851.79986593  2135.5611788   2864.181       1848.7

pinhead_x
pinhead_y
pinhead_z

specifies the XYZ coordinate for the hea

pintail_x
pintail_y
pintail_z

specifies the XYZ coordinate for the tail 
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Vertical Fault Files (.vflt )
r while viewing a scattered data or an 
p of the model or as vertical transparent 
ender tab; refer to the Render Tab section 

. Vertical fault files must have names that 

er while viewing a 2D grid, 3D grid, 
olygons at the top Z-level of the model or 
 controlled by the Render tab; refer to the 
sting this file type. Polygon files must have 

olygons relative to X,Y locations in the 
iles: attribute-style annotation and ISM 
hics’ predecessor to EarthVision). The main 
nnotation parameters (e.g., font, symbol 
Vision. A simple example annotation file is 

ator
3D Viewer EarthVision 8.0

Vertical fault files are used for display in the Demo 3D Viewe
encrypted faces file. Faults can be displayed as lines at the to
curtains. The display of vertical fault files is controlled by the R
of this document for more information on posting this file type
end with .vflt.

Polygon Files (.ply, .nvflt, .vply)
Polygon files are used strictly for display in the Demo 3D View
scattered data, or a faces file. These files are displayed as p
as vertical transparent curtains. The display of polygon files is
Render Tab section of this document for more information on po
names that end with .nvflt, .ply, or .vply. 

Annotation Files (.ann)
Annotation files are used to display text, lines, symbols, and p
Demo 3D Viewer. Two formats are supported for annotation f
style annotation (Interactive Surface Modeling, Dynamic Grap
difference between the two is the method for specifying the a
type, color, etc.); however, either format is acceptable for Earth
reproduced below.

# Type: annotation data
# Version: 76
# Format: free
# Field: 1 x
# Field: 2 y
# Projection: Universal Transverse Merc
# Zone: 30
# Units: meters
# Ellipsoid: Hayford International 1924
# End:
version 7.0
setatr "Polygon default"
setatr "Polygon boundary default"
srfply
52036.08645762422.353
52027.26485762199.995
52022.8545762088.817
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51945.3735761869.184
51872.29975761760.73
51726.14425761543.827

r scene, such as all the displayed models 
s include settings such as slice locations, 
even the background color. Vue files allow 
set up a default display of a 3D model or 
cified in a vue file are changed when the 

 –> Save Vue Display (Ctrl W hot key).

o the new Demo 3D Viewer results in a 
mple instructions such as the viewing 

 on a scanned image (various formats, 
tes. An image registration file contains the 
hich are correlated with three pairs of 
o 3D Viewer to drape an image on a 3D 

ing the image file name is the world XY 
origin (0,0) for the pixel coordinate pair is 
image registration file:
28 EarthVision 8.0 2

51584.39635761438.105
51447.0655761443.566
51305.3085761337.853

Vue Files (.vue, )
Vue files contain a complete definition of the Demo 3D Viewe
and files, as well as their viewing positions. These specification
displayed isovalue shells, color files, displayed auxiliary files, 
the user to save a complete set of instructions to, for example, 
data set, or set up a series of displays. Only those settings spe
file is read.

Vue files are created in the Demo 3D Viewer by selecting File

Loading a vue file from previous Demo 3D Viewer versions int
warning message. The vue file is loaded, but only relatively si
parameters are read.

Image Registration Files (.imreg)
Image registration files contain information to correlate pixels
including .jpg, .rgb, .tif) to data scale (i.e., real world) coordina
image file name, and three pairs of data scale coordinates, w
pixel coordinates. Image registration files are used in the Dem
model or 2D surface. 

The image file name must be the first record in the file. Follow
coordinate and pixel coordinate for each reference point. The 
the lower left hand corner. The following is an example of an 

islay.rgb
37916.000000 76250.000000
527 497
42500.000000 77500.000000
516 482
43333.000000 70416.000000
526 429



29

Screen Dump Files (.rgb, .jpg, .bmp, .tiff, and .png)
 saved to a file by selecting File –> Save 
 types. The available formats are an SGI 
ed on the screen or sent to a printer.

n, etc. in the Demo 3D Viewer, all parame-
le created by the Well Display File Editing 
 parameters, and a list of the well IDs to 
3D Viewer EarthVision 8.0

A computer “picture” of a model display on the screen can be
Raster Image. This picture is saved to one of several binary file
.rgb, .gif, .jpeg, .bmp, .tiff or .png. The file can later be display

Binary Well Display Files
In order to display well paths, log curves, well-bore annotatio
ters for display are specified in a binary well display (.bwd) fi
program. These files include the well path information, display
be displayed.
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Chapter 3: Using the Demo 3D Viewer Interface
 easily manipulate a 3D model, an ASCII 
pter specifically discusses the Demo 3D 
iewer, as well as how to use all aspects of 

, usage of menu items, etc. The Demo 3D 
 capable EarthVision 3D Viewer, the 
ntation covers only the functions avail-
30 EarthVision 8.0 2

The Demo 3D Viewer’s graphical user interface allows users to
scattered data file or many other file types with ease. This cha
Viewer interface: what to expect upon entering the Demo 3D V
the interface, for example, different mouse button capabilities
Viewer has limited functionality compared with the much more
WellArchitect Viewer, and the CoViz 4D Viewer. This docume
able in the Demo 3D Viewer.
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Starting the Demo 3D Viewer
 file provided by Dynamic Graphics.

g on a *.bat file that we provide. USGS is 
les. It isn't as simple as just double-clicking 
n.exe with about 20 other DLLs. So we will 
k on it. We could, I suppose designate the 
ay that individual distributions may other 

ppears listing all the available encrypted 
 Demo 3D Viewer. An encrypted faces file 
types can be loaded.

ols on the left to navigate to another direc-
ove the Demo 3D Viewer’s working direc-

button, the selected file is displayed in the 
phic region to the left (also referred to as 

o referred to as the Panel) by default. The 

 the Demo 3D Viewer Model window.

pane near the top, and a series of tabs 
cted by clicking with the left mouse button 
., on top of the series of tabs) by default.

t are used to perform general functions on 
 files, zoom/pan, control file display, and 

indow that include File, Edit, View, 
3D Viewer EarthVision 8.0

The Demo 3D Viewer is started by double-clicking on the *bat

CINDY:  edit this:  Users will probably start it by double-clickin
likely to provide multiple *.bat files that start it with various fi
on the executable because we have to bundle the demoviewer
tuck it away in a sub-folder and then have the user double-clic
name "demoviewern.bat" for the bat file name and then just s
other launch options.

The Initial Screen Display

Upon entering the Demo 3D Viewer, a File Selection window a
faces files in the current directory that can be displayed in the
must be loaded into the Demo 3D Viewer first, then other file 

A file that is in another directory can be chosen using the contr
tory. The Demo 3D Viewer remains in the same directory. To m
tory to a new directory, select File –> Change Directory.

After selecting an encrypted faces file then clicking the Open 
Demo 3D Viewer. The Demo 3D Viewer is displayed with a gra
the Model window) and a Menu Panel window to the right (als
initial screen display contains these main elements:

 The model (the encrypted faces file) presented within

 The Demo 3D Viewer Panel contains a File Selection 
below for each of the menus. These menus can be sele
on the desired menu tab. The Slice tab is selected (i.e

 Controls along the margins of the Model window tha
the Demo 3D Viewer display such as open files, save
set lighting, among numerous other functions.

 Pull-down menus on the top menu bar of the Model w
Window, Display, Query, Tools, and Help.
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Initial Model Display
e File Selection window when entering the 
d for the display. These colors, based on 
color that previously represented the 
s on the Visible tab. 

l and the Z-axis is labeled on either the 
r. The three coordinate axes are 

ccupied by the menus. The Z- or 
 reasonably proportioned block or wire 
age 14 show the wire frame surrounding 
nits are often different than those of X and 
many times greater than the Z-range even 
 the Z-Exaggeration section of this 

main (Z increases downward) or elevation 
e viewing session is decided according to 

a are in elevation, then the Demo 3D 

during the session, then the Demo 3D 
play. For example, if depth data are 

n the depth data is displayed correctly in 
ndle all data irrespective of their vertical 

L
 referenced to its own vertical datum; 
with respect to all other files. In this regard 
etermines how the data are viewed (i.e., 
h file’s “Z datum above Mean Sea Level” 
32 EarthVision 8.0 2

The initial model shown is the first file that was selected using th
Demo 3D Viewer. The default Demo 3D Viewer colors are use
the model’s information, can be altered or reversed (e.g., the 
highest P-value would then represent the lowest) using function

The X- and Y-axes are labeled on the lower front of the mode
left or right side of the model, whichever is closer to the viewe
highlighted in red, green, and blue respectively.

The model is scaled to fit within the portion of the screen not o
vertical-exaggeration is automatically calculated to provide a
frame that contains the complete model. (The illustrations on p
the model.) This scaling is necessary since the Z measurement u
Y. Additionally, it is not unusual for the X- and Y-ranges to be 
when the X- and Y-units and the Z-units are the same. Refer to
document for more information on Z-Exaggeration.

Elevation vs. Depth
The Demo 3D Viewer can display models in either the depth do
domain (Z increases upward). The default Z direction in any on
the first data loaded into the Demo 3D Viewer. If the first dat
Viewer session has Z increasing upwards, and vice versa.

If data with the opposite sign convention are introduced later 
Viewer automatically converts the sign of this new data for dis
loaded to a Demo 3D Viewer session running in elevation, the
the elevation domain. In this way, the Demo 3D Viewer can ha
coordinate sign convention.

Viewer Z Origin and Z Datum above MS
Each file loaded to the Demo 3D Viewer environment may be
therefore each must be positioned correctly in a vertical sense 
the Viewer displays two settings: a global “Z Origin,” which d
where is the Viewer’s Z=0 relative to mean sea level) and eac
(i.e., where the file’s Z=0 is relative to mean sea level).
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Z Origin—Viewing Files Relative to any Vertical Datum
 equal 0 at mean sea level (MSL) (for 
tions relative to local topography). The “Z 
s is a global parameter meaning it is used 
SL (i.e., if Z=0 is above MSL, the differ-

 Sea Level” setting in the first file loaded 
 Origin is set to 0 (i.e., MSL).

reen 3D compass, if the Z Origin is not 0, 
elow for more details on these features).

l Reference
vertical datum from which all Z values in 
Z = 0 in a specific file). In other words, the 
L; they could be measured from a Kelly 
Files with multiple different Z datums can 
er, and are automatically corrected for 
orrect.

, see Appendix A: Shared Components and 

del Display
id file, or ASCII scattered data file can be 

inside the Demo 3D Viewer. These files, 
gs for the initial model display, i.e., set up 
d by parameters (e.g., a keyword for the 
II, with each keyword and parameter on 
3D Viewer EarthVision 8.0

In the Viewer (and throughout EarthVision), Z is not required to
example, all depths might be relative to a drilling rig or eleva
Origin,” therefore, sets how Z=0 relates to mean sea level; thi
throughout the Viewer and is set in terms of elevation above M
ence is a positive “Z origin”).

Typically, the Z origin is taken from the “Z datum above Mean
into the Viewer; if it is not set in the file, or is undefined, the Z

The current setting of the Z Origin is shown alongside the onsc
i.e., the Z Origin is not mean sea level. (Refer to the sections b

Z Datum Above MSL—File-specific Vertica
“Z datum above MSL” is a file-specific setting. It specifies the 
that files are referenced (i.e. the elevation above MSL where 
Z values in any file are not required to be measured from MS
Bushing (KB), a seismic datum, or some other non-MSL datum. 
be loaded and displayed simultaneously in the Demo 3D View
their different datum values so that the relative Z values are c

For a full discussion of these file settings and Viewer behavior
Conventions.

Vue File Usage to Change the Initial Mo
A file containing default positions for a particular faces file, gr
created inside or outside of the Demo 3D Viewer for display 
called “vue” files, are used to automatically load custom settin
the initial view of the file. The file consists of keywords followe
azimuth, followed by the value of the azimuth). The file is ASC
one line, separated from others by a carriage return. 
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File Pull-down Menu

 file into the Demo 3D Viewer using a File 
. See File Selection Window for more infor-

tly active file to a user-specified file name

ow listing the files currently in the Demo 3D 
 group of files other than the encrypted 
 selected and removed from the Demo 3D 
ded, the encrypted faces file can not be 

e Demo 3D Viewer.

tions: Load Vue produces a File Selection 
ng the vue (.vue) files in the current folder 
tory; the selected vue file is loaded into 
wer; Load Recent Vue lists the ten most 

e files or vue frames for loading; Viewing 
 loads only the viewing parameters (e.g., 
th, lighting parameters) from a specified 
 via a File Selection window). See Vue 
ormation.

 display settings as a vue (.vue) file.

ge Capture window from which an output 
dow image (without the tool bars, etc.) can 
e image size (i.e., actual window size, user 
e, or maximum resolution), image file 
 RGB, JPEG, or BMP), and file name are 
ge format quality of Basic (60% quality), 
ality) or Fine (95% quality) is specified for 

t Model window image to the computer 
t it can then be pasted into any program 
 clipboard.
34 EarthVision 8.0 2

The File pull-down menu contains the following functions:

 Open . . . . . . . . . . . . . . . . . . . . . . . . loads an existing
Selection window
mation.

 Copy . . . . . . . . . . . . . . . . . . . . . . . . copies the curren

 Remove  . . . . . . . . . . . . . . . . . . . . . . produces a wind
Viewer; a file or
faces file can be
Viewer. Once loa
removed from th

 Load Vue  . . . . . . . . . . . . . . . . . . . . contains three op
window displayi
or working direc
the Demo 3D Vie
recently used vu
Parameters Only
inclination, azimu
vue file (selected
Files for more inf

 Save Display to Vue . . . . . . . . . . . . saves the current

 Save Raster Image  . . . . . . . . . . . . . produces an Ima
of the Model win
be generated. Th
defined pixel siz
format (i.e., TIFF,
specified. An ima
Normal (80% qu
JPEG files.

  Copy Image to Clipboard . . . . . . . copies the curren
clipboard so tha
that accesses the
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 Change Directory  . . . . . . . . . . . . . . produces a File Selection window, from which an existing 
directory can be selected or a new directory created 

ows only).

D Viewer, closing the Model and Panel 

n window, shown below, in which a file can 
 display the file in the Viewer.

it, and Text Edit buttons at the bottom of 
3D Viewer EarthVision 8.0

(Microsoft Wind

 Exit. . . . . . . . . . . . . . . . . . . . . . . . . . exits the Demo 3
windows.

File Selection Window
Selecting File –> Open –> “file type” produces a File Selectio
be selected. After selecting a file(s), select the Open button to

In the Demo 3D Viewer, the Statistics, Header, View, Graphic Ed
the window are inactive.



009 Dynamic Graphics, Inc. All Rights Reserved.

Edit Pull-down Menu
 shown below, used to establish settings 
e the Demo 3D Viewer program is started.

emo 3D Viewer display window. The 
ed explicitly or continuously, as specified 
xplicitly means save the window layout 
hen the Save Now button is selected. 

hat the window layout is automatically 
 exits the Demo 3D Viewer. The 3D 
x sets whether or not toolbars are 
D Viewer. The Keep Backgnd Color 
r the current settings for black/white 

sed each time the Demo 3D Viewer is 
 can be set such that the File Selection 
abbed menus (by selecting the Vertical 
e of the tabbed menus (by selecting the 
f set to Horizontal, the File Selection on Left 
 the File Selection pane is to the left or the 
.

36 EarthVision 8.0 2

Selecting Edit –> Preferences produces a Preferences window,
(e.g., the current window geometry) that are applied every tim

The Preferences window contains the following tabs:

 Window . . . . . . . . . . . . . . . sets preferences for the D
window layout can be sav
in Save Window Layout. E
right now, but only once, w
Whenever Exiting means t
saved every time the user
Window Toolbars checkbo
displayed for the Demo 3
checkbox specifies whethe
reversal are saved and u
entered. The Panel layout
pane is either above the t
radio button) or to the sid
Horizontal radio button). I
checkbox controls whether
right of the tabbed menus
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 Render . . . . . . . . . . . . . . . . sets preferences for point rendering, lighting and display lists. The 
Point Rendering Count is the number of points above which data 

ingle pixel points, rather than resizable 
l Scale controls the relative scale for 
 Time Limit is the time limit beyond which, 
l with the mouse, a simpler line rendering 
dels, grids, etc., are displayed as 
lly rendering the data during rotation. The 
on sets the pixel resolution for draping 
solution lower results in faster rendering; 
 2048, and 4096 pixels. A higher amount 
increased render time; a smaller amount 
ut faster render times. Annotation draping 
 unpredictable when used on computers 
s boards. If the annotation draping results 

ous, decrease the Annotation Drape Resolu-
pply Point Render to Ellipsoids/Ellipses 
r or not those symbol types are displayed 
disks when point rendering is turned on. 
 checkbox controls whether the current 
aved and used each time the Demo 3D 
e OpenGL Display Lists If Available 
r display lists are used for rendering some 
nder faster. Also note the 4dv files will 

RAM when the OpenGL Display lists are in 
mediate Sliders at Startup checkbox 
diate Slider Update icon is enabled or 
rtup, the initial setting for the Immediate 
rs the current rendering performance.

shold. The defaults for this user-adjustable 
-bit OS, and 500 Mb for 64-bit OS. 3D 
m memory and can cause problem on 

 Hence addition memory savings routines 
ce impact) take effect when loading 3D 

pdating and vue errors. The Ignore Vue/
ines if any errors encountered when a vue 
is missing from the specified directory) 
pop-up window (the default setting is off) 
ld be set on). The File Updating section 
3D Viewer EarthVision 8.0

points are displayed as s
cubes. The Default Symbo
symbols. The Mouse Drag
when dragging the mode
model is used; that is, mo
wireframes rather than fu
Annotation Drape Resoluti
annotation. Setting the re
the resolutions are 1024,
results in finer detail, but 
results in coarser detail, b
at high resolution may be
with less powerful graphic
in the Viewer look errone
tion and try again. The A
checkbox controls whethe
as points or as ellipsoids/
The Save Current Lighting
lighting parameters are s
Viewer is entered. The Us
checkbox controls whethe
model types which may re
occupy a lot more system 
use. The Always Disable Im
controls whether the Imme
disabled. On program sta
Slider Update icon conside

3D grid optimization thre
option are 150 Mb on 32
grids occupy a lot of syste
systems with limited RAM.
(with the minor performan
grids above this file size.

 File. . . . . . . . . . . . . . . . . . . sets preferences for file u
vlist Errors setting determ
file is loaded (e.g., a file 
should be displayed in a 
or not (the checkbox shou
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controls whether files loaded in the Demo 3D Viewer are potenitally 
updated if the files are changed on disk. The selections are Ask 

 Update. The Update Frequency is specified 

ute colortables and multiple Z fields. The 
crete Attributes specifies whether colors 
 between two or more files that have 
 same field name. The Share Color Tables 
cifies whether colors are automatically 
ore files that have numeric attributes with 
Scattered Data option on this tab allows 
e file with the attribute called “z” as the 
 option is not selected, and if the file 
ld that might represent the vertical coordi-
 appears while the file is loading, giving 
ct which field represents the vertical 
te attribute checkboxes sets the maximum 
tes viewable on the Visible tab. The 

 a file is found in $COVIZHOME/etc/
evview.pref is loaded.

 for all the tabs. Selecting Restore Default 
less of what tab is currently displayed. 

e Preferences window. Selecting Cancel 
ce changes.

 in the Demo 3D Viewer are discussed 
38 EarthVision 8.0 2

Before Updating or Never
in seconds.

 Attribute. . . . . . . . . . . . . . . sets preferences for attrib
Share Color Tables for Dis
are automatically shared
discrete attributes with the
for Numeric Attributes spe
shared between two or m
the same field name. The 
the user to always load th
vertical coordinate. If this
contains more than one fie
nate, then a pop-up menu
the user the option to sele
dimension. The Max discre
number of discrete attribu
default is 2000.

Preferences are saved in $HOME/.evview/evview.pref. If
evview.pref, it is loaded first, and then $HOME/.evview/

The Restore Default, OK, and Cancel buttons function the same
sets the preferences to their default values for all tabs, regard
Selecting OK saves the currently set preferences and closes th
closes the Preferences window without applying any preferen

View Pull-down Menu
The functions on the View pull-down menu that are available
below.
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View –> Lighting
, shown below, that is used to set various 

rs include the following:

 non-directional light source meaning that 
model equally from all directions. Ambient 
cted equally in all directions. The effect on 
pendent of the position of the model and 
f the eye. The default Scene Ambience 
n arbitrary scale of 0 to 1. Moving the 

the right, thus increasing the scene 
s a highly lit, paler scene. Decreasing the 

(moving the handle to the left) creates a 
ene. In addition, a value can be entered 
ng with the left mouse button on the value 
g in the desired value.

ribes to what degree the directional light 
e 3D model. The reflected light tends to 
 a three-dimensional quality, although in 
3D Viewer EarthVision 8.0

Selecting View –> Lighting produces a Lighting Control window
lighting parameters for the Model window. Lighting paramete

 Scene Ambience  . . . . . . . . . . . . . . . Ambient light is a
it illuminates the 
light is also refle
the model is inde
the orientation o
value is 0.3, on a
slider handle to 
ambience, create
scene ambience 
darker, richer sc
directly by clicki
box and enterin

 Material Specularity . . . . . . . . . . . . Specularity desc
is reflected by th
give the surfaces
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some cases the user may want to change the reflectivity 
(e.g., when a slice is pointed directly at the eye point, a 

e material specularity causes the face to 

reflects 0% of the directional light, the 
o have a matte surface. No directional 
 back to the user; therefore, no highlights 
model. This type of matte surface is 
ble when highlights obscure details of the 

reflects 100% of the directional light, the 
d highlights on the surface of the model, 

 the model, the position of the light source, 
 view. A highly specular surface produces 
n add realism to a 3D model.

ng for the material specularity is 0.5 (the 
f reflective light). Changing this setting 
flectivity of the model, with a setting of 0 
flected light. In addition, a value can be 
by clicking with the left mouse button on 
d entering in the desired value.

tness or intensity of the light source. The 
less intense) to 1 (most intense), with a 
ddition, a value can be entered directly 
he left mouse button on the value box and 
esired value.

irection in the horizontal plane from the 
look point (generally the center of the 
.0 is looking from the user towards the 
permissible range is from -90 to +90, with 
hanging the inclination and azimuth of the 
ges how the user views the model, what 
el are illuminated, how much light is 
ward the eye point, etc. When the 

ination are both at 0, the light sources are 
he eye point.

 the horizon or horizontal plane that 
point and the look point, measured as 
rmissible range is from -90 to +90, with a 
40 EarthVision 8.0 2

high value for th
appear white).

When a surface 
model appears t
light is reflected
are seen on the 
sometimes desira
model.

When a surface 
user sees reflecte
depending upon
and the angle of
highlights that ca

The default setti
median amount o
decreases the re
indicating 0% re
entered directly 
the value box an

 Light Source Intensity . . . . . . . . . . . . controls the brigh
range is from 0 (
default of 1. In a
by clicking with t
entering in the d

 Light Source Azimuth . . . . . . . . . . . . The heading or d
eye point to the 
model), where 0
workstation. The 
a default of 0. C
light source chan
parts of the mod
reflected back to
azimuth and incl
directly behind t

 Light Source Inclination  . . . . . . . . . . The angle above
includes the eye 
degrees. The pe
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default of 0. Changing the inclination and azimuth of the 
light source changes how the user views the model, what 

el are illuminated, how much light is 
oward the eye point, etc. When the 
ination are both at 0, the light sources are 
he eye point.

 one or two directional light sources are 
 only one light source is on. When this 
ked, a second light source illuminates the 
econd set of lighting controls becomes 

 of the Demo 3D Viewer display lighting 
pdate Scene or the OK button is selected. 
e changes can be made to the lighting 
e is redrawn.

raws the Demo 3D Viewer display with the 
ameters.
3D Viewer EarthVision 8.0

parts of the mod
reflected back t
azimuth and incl
directly behind t

 Use Second Light Source . . . . . . . . . controls whether
used. By default
checkbox is chec
model and the s
active.

 Defer Update . . . . . . . . . . . . . . . . . delays a redraw
until either the U
That way multipl
before the imag

 Update Scene . . . . . . . . . . . . . . . . . immediately red
new lighting par
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View –> Axes and Labels
window, shown below, in which axes and 
ols include:

ox displays the axes lines; unchecking the 
s lines are not displayed.

width. The default is 1 pixel. If there is 
ce in the Viewer, this setting will affect all 

nes, labels, and captions. A color palette is 
olor can be selected or custom colors can 
42 EarthVision 8.0 2

Selecting View –> Axes and Labels produces the Axes Control 
label posting parameters are specified. Axes and labels contr

 Axes. . . . . . . . . . . . . . . . . . checking the Axes checkb
checkbox means that axe

 Axes Pixel Width. . . . . . . . select the axes line pixel 
more than one model spa
model spaces.

 Color . . . . . . . . . . . . . . . . . select the color for axes li
displayed, from which a c
be created.
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 Labels  . . . . . . . . . . . . . . . . checking the Labels checkbox displays the axes labels; un-checking 
the checkbox means that axes labels are not displayed.

l width. The default is 1 pixel. A larger 
er labels. If there is more than one model 
etting will affect all model spaces.

 labels and captions. Size is relative, for 
rger than a size of 1.

 checkbox displays the North arrow; un-
ans that no North arrow is displayed.

sition, either at the Zmin or Zmax of the 

box displays a scale bar; un-checking the 
cale bar is displayed.

en adjacent X, Y, and Z tickmarks.

e from which the X, Y, and Z tickmarks are 

, Y, and Z axes.

e measurement tick mark lattices along 
3D Viewer EarthVision 6.0

 Labels Pixel Width  . . . . . . select the axes label pixe
pixel width results in bold
space in the Viewer, this s

 Size . . . . . . . . . . . . . . . . . . select the size of the axes
example, a size of 2 is la

 North Arrow. . . . . . . . . . . . checking the North Arrow
checking the checkbox me

 North Arrow Position . . . . . select the North Arrow po
model.

 Scale Bar. . . . . . . . . . . . . . checking the Visible check
checkbox means that no s

 Tickmark Intervals . . . . . . . specify the interval betwe

 Tickmark Reference . . . . . . specify the reference valu
calculated.

 Captions  . . . . . . . . . . . . . . specify captions for the X

The Lattice tab, shown below, controls the display of wirefram
each of the axis planes.
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t be changed because the Demo 3D 
space.

have their visibilities controlled indepen-
. Also, the three “front” or “back” lattices 
simultaneously using the appropriate 
“front” and “back” will adapt as the 3D 
less the lock icon is depressed, in which 
k” lattices are frozen to their current 

axis scroll bars are used to specify the 
tion for the lattices.

the lattice. The options are 1 (the default), 
er is a thinner line width; a larger number 
44 EarthVision 6.0 2

 Space Selection . . . . . . . . . the space selection can no
Viewer uses only a single 

 Lattice Visibilities . . . . . . . . The six lattice planes can 
dently using these settings
can be toggled on or off 
buttons. The notion of 3D 
visualization is rotated un
case the “front” and “bac
positions.

 Lattice Positions . . . . . . . . . the X-axis, Y-axis, and Z-
exact X, Y, and/or Z loca

 Lattice Line Width . . . . . . . specify the line width for 
2, 3, or 4. A smaller numb
is the thicker line width.
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 Snap to Ticks . . . . . . . . . . . selecting this option will ensure that the lattice panels are always 
aligned with a major tick mark on the axes.

s the lattice positions back to the default.

:

rrent Model window as it is currently 
 Model window appears, sized approxi-

 size of the original Model window. When 
o one Model window, it also shows up in all 
dows. The same is true for color tables: 
ble is changed in one Model window, it 

odel windows. Some parameters may vary 
 Model windows: the viewing parameters, 
ed by the thumbwheels (i.e., azimuth, incli-
, zoom), and the vertical toolbar icon 
nter mode, magnifier, double buffering, 
ing).

l window geometry, such as size and 
onitor screen, to its original, default 

lay of the toolbars surrounding all four 
el window. By default, they are displayed.

 single and double buffer modes. By 
 shown on the Model window are drawn in 
ode, except on 8-bit color workstations. 
ode means that if any changes are made 
r example, changing the azimuth or 
 file), the new display is drawn in the 

he back buffer) until it is complete. Once 
ought to the foreground (the front buffer), 
ee the display.

seful to see the display while it is drawing: 
or of a model, or, if the model takes a long 
o monitor its progress. To view the redraw, 
3D Viewer EarthVision 6.0

 Reset . . . . . . . . . . . . . . . . . selecting this option reset

Window Pull-down Menu
The Window pull-down menu contains the following functions

 New View . . . . . . . . . . . . . . . . . . . . duplicates the cu
displayed. A new
mately 25% the
a file is added t
other Model win
when the color ta
changes in all M
among different
mostly represent
nation, lookpoint
settings (i.e., poi
perspective view

 Reset Window Geometries . . . . . . . resets the Mode
position on the m
geometry. 

 Toolbars. . . . . . . . . . . . . . . . . . . . . . toggles the disp
sides of the Mod

 Double Buffer Mode . . . . . . . . . . . . toggles between
default, the files
double buffer m
Double buffer m
to the display (fo
bringing in a new
background (in t
complete, it is br
so the user can s

Sometimes it is u
to view the interi
time to redraw, t
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double buffer mode must be turned off (putting the display 
in what is known as single buffer mode).

ode is on by default.

ult black background color to white and 
 foreground color to black. This is useful 
age is being sent to a printer. In addition, 

screen annotation having a white color are 
 black. Holding down the Ctrl key while 
e Reverse Black/White icon button cycles 
es of gray.

r palette from which a color can be 
s the background color for the Model 
ult, the background color is black). Custom 

be created.

und color change. To do so, rotate the scene 

hin a wire frame, known as the axes, with 
 to the front of the screen. A compass 
emo 3D Viewer. The commands on the 
xes, labels, 3D Cursor, color key, and 
selections:

ire frame or axes on or off. By default, 
played.

e tick marks and numeric labels along the 
 of the labels and tick marks is, therefore, 

he axes display. By default, the labels and 
n.

sor on or off. By default, the cursor is off. 
D Viewer Cursor for more information.

 Color Keys displayed. By default, the 
 active file’s attribute (by which the file is 
yed in the upper left-hand corner of the 
46 EarthVision 6.0 2

Double buffer m

 Reverse Black/White. . . . . . . . . . . . switches the defa
the default white
when a screen im
data points and 
also swapped to
left-clicking on th
through five shad

 Set Background Color . . . . . . . . . . . brings up a colo
selected to use a
window (by defa
colors may also 

Note: Sometimes a redraw must be forced to see the backgro
slightly.

Display Pull-down Menu
The files loaded into the Demo 3D Viewer are displayed wit
tick marks and labels displayed along the three axes closest
appears in the lower left corner of the screen to orient the D
Display pull-down menu control the display (on/off) of the a
compass. The Display pull-down menu contains the following 

 Axes. . . . . . . . . . . . . . . . . . . . . . . . . turns the model w
the axes are dis

 Labels  . . . . . . . . . . . . . . . . . . . . . . . turns on or off th
axes. The display
independent of t
tick marks are o

 3D Cursor  . . . . . . . . . . . . . . . . . . . . turns the 3D Cur
See The Demo 3

 Color Key(s) . . . . . . . . . . . . . . . . . . . turns on/off any
Color Key for the
colored) is displa
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Model window. Multiple Color Keys can be displayed 
simultaneously by right-clicking on the current color key, 

w from the pop-up menu that appears. 
 on the pop-up menu are: Show (when set 
> Color Key(s) function is used to turn it 

 Lock (locks the current color table to this 
emove, and Font Sizes (controls font size for 

X, Y, Z compass (i.e., axis orientation 
fault the compass appears in the lower left 
del window; the compass can be dragged 
n using the left mouse button (the mouse 
o a cross bar when positioned for 
ompass shows the current direction of the 
d Z axes (joining at the minimum X, Y, and 
e principle axes of the model's wire frame 
e orientation diagram and are drawn in 
.e., the X axis is red, Y axis is yellow, and Z 
 axis orientation diagram rotates with 
ight clicking on the compass rose within the 

r brings up additional options to control the 
ass on-screen, and the option to display 
e “Z origin” setting beneath the compass 

u in the Demo 3D Viewer.

in the Demo 3D Viewer.
3D Viewer EarthVision 6.0

then selecting Ne
Additional items
off, the Display –
(them) back on),
configuration), R
the color key).

 Compass  . . . . . . . . . . . . . . . . . . . . . turns on/off the 
diagram). By de
corner of the Mo
to a new locatio
cursor changes t
dragging). The c
principle X, Y, an
Z point). The thre
correspond to th
the same color (i
axis is blue). The
model rotation. R
Demo 3D Viewe
size of the comp
the Viewer spac
on-screen.

Query Pull-down Menu
There are no functions available on the Query pull-down men

Tools Pull-down Menu
There are no functions available on the Tools pull-down menu 
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Help Pull-down Menu
 the Demo Viewer. In addition to these 
ls and icons. Hover the mouse pointer 
ox.

o 3D Viewer documentation

 the Demo Viewer hotkeys or keyboard 

 the latest 3D program changes.

ion number, date, and licensing informa-
o 3D Viewer, and contact information for 
cs.

dow

D Viewer Model window are used to 
ning the mouse cursor over an icon button 

 of the icon buttons are described in the 

uttons and the button names. Not all icon 
ed on the following diagram for reference 
48 EarthVision 6.0 2

Various types of help are available for assistance in running
menu options, “ToolTip” help is also available for specific too
above the tool of interest, and the help appears in a small b

 Documentation . . . . . . . . . . . . . . . . . Displays the Dem

 Keyboard Shortcuts . . . . . . . . . . . . . Displays a list of
shortcuts.

 What’s New. . . . . . . . . . . . . . . . . . . Displays a list of

 About the EarthVision Demo . . . . . . Displays the vers
3D Viewer tion for the Dem

Dynamic Graphi

Icon Buttons Around the Model Win

The numerous icon buttons around the perimeter of the Demo 3
maneuver, manipulate, and edit in the Demo 3D Viewer. Positio
produces tool-tips that describes the icon button function. Each
sections that follow.

The following diagram is a quick reference showing the icon b
buttons are active in the Demo 3D Viewer, but they are display
purposes.
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1. Selection/Query Tool
2. Manipulate Tool
3. Screen Annotation Tool
4. Centering Tool
5. Quick Measurement Tool
6. Reset All Viewing Parameters
7. Magnifier Tool
8. Reverse Background Color (black/white)
9. Toggle Perspective/Orthographic Views
10. Inclination Thumbwheel
11. Inclination Text Box
12. Reset Azimuth & Inclination
13. Switch to XY “Map” Mode
14. Orient to XY Perspective View
15. Orient to ZX Perspective View
16. Orient to ZY Perspective View
17. Azimuth Thumbwheel
18. Azimuth Text Box
19. Z-exaggeration/Temporal Slider Toggle
20. Z-exaggeration Text Box
21. Reset Z-exaggeration
22. Lock Z-exaggeration
23. Horizontal Pan Thumbwheel
24. Reset Lookpoint to Defaults
25. Vertical Pan Thumbwheel
26. Reset Zoom to Default
27. Zoom Thumbwheel
28. Save vuelist
29. Advance vuelist Backward/Forward
30. Select vuelist from List
31. Delete Current vue Frame
32. Capture vue Frame
33. Synchronized Viewer
34. Temporal Interface
35. Instant Volumetrics
36. Set Axes, Labels, and Captions
37. Lighting Dialog
38. Realizations Dialog
39. Layout Spaces
40. Toggle 3D Cursor Snapping
41. 3D Cursor Interface
42. Toggle 3D Cursor
43. Save Edits
44. Open Data Registry Window (Only 

available in CoViz 4D)
45. Load File
3D Viewer EarthVision 6.0
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Open
election window listing all of the file types 
ata, images, and vue files). A single file is 
files are selected by holding down the 
cutive files are selected by holding down 

he first file, the last file, and all the files in 
s are loaded into the Demo 3D Viewer 
s selecting File –> Open.

displays a 3D cursor in the Model window. 
cation (discussed next). The X/Y/Z location 
odel window on the right hand side; the 
pace is upwards (in elevation; Z increases 
50 EarthVision 6.0 2

Selecting the Open (load a file) icon button produces a File S
that can be loaded into the Demo 3D Viewer (e.g., models, d
selected by clicking on it with the left mouse button. Multiple 
Ctrl key while selecting various file names. A series of conse
the Shift key while selecting the first file and the last file; t
between the two are automatically selected. The selected file
display. Selecting the Open icon button has the same effect a

3D Cursor
Selecting the 3D Cursor icon button (or the Ctrl+K hot key) 
The 3D Cursor can then be used for snapping to a point or lo
of the 3D Cursor is always displayed at the bottom of the M
location includes the X, Y, and Z units, and also if the model s
upwards) or downwards (in depth; Z increases downwards).
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3D Cursor Positioning and Measurement
tton displays a 3D Cursor in the Model 
or Dialog window, shown below. The 
 is discussed below:

ursor location, display, and measurement

 and Z scale bar interval, whether the 3D 
ed and/or shaded, and the pixel width of 
ale bar XY and Z intervals specified here 
he interval by which the cursor moves when 
 on the Location tab.
3D Viewer EarthVision 6.0

Selecting the 3D Cursor Positioning and Measurement icon bu
window, if one is not already there, and produces a 3D Curs
following tabs are in the 3D Cursor Dialog window, and each

 Location . . . . . . . . . . . . . . . . . . . . . . controls the 3D c

 Options . . . . . . . . . . . . . . . . . . . . . . controls the X, Y,
cursor is subdivid
the cursor. The sc
also determine t
using the arrows
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Location Tab

 location of the 3D cursor can be specified 
ars or by entering the exact location

Y, and Z axes can be displayed either as 
) or as transparent planes. When planes 
r location can be changed by clicking or 
 part of an exposed plane; when the axes 
licking on any axis moves the 3D Cursor to 

 button adds another 3D Cursor at the 
nd adds a line to the 3D Cursor table 
w. The new cursor will not be visible until it 

w location. Selecting the Delete button 
ursor that is highlighted in the 3D Cursor 
s are displayed in unique colors to distin-
nother. The first 3D Cursor is red, the 
 the third is green, and clicking on the color 
u to select a cursor color. A red outline 
tive cursor’s text box (e.g., Cursor 1 or 
 the Model window, cross hairs appear 
hat cursor, while the other cursor mark 
oss hairs.

displays the most recent 3D cursor location 
ous locations in black. Selecting Measure 
rements between two or three 3D cursor 
cursor locations are used is set by clicking 
 green ruler) icon in. Selecting Current 
s only the X, Y, Z locations of each 3D 

s of 3D cursor values.

nns of 3D cursor values to the system 
e in any program that can paste from a 

 of current 3D cursor locations to a user-
ed data file and loads this file into the 
r.
52 EarthVision 6.0 2

The following controls are on the Location tab:

 X-, Y-, and Z-axis Locations . . . . . . . the exact X, Y, Z
using the slider b

 3D Cursor Planes . . . . . . . . . . . . . . . the 3D cursor X, 
lines (the default
are on, the curso
dragging on any
are displayed, c
that location.

 3D Cursor Marks . . . . . . . . . . . . . . . selecting the Add
current location a
immediately belo
is moved to a ne
deletes the 3D C
table. 3D Cursor
guish one from a
second is yellow,
button allows yo
surrounds the ac
Cursor 2) and, in
extending from t
does not have cr

 Mode . . . . . . . . . . . . . . . . . . . . . . . . selecting History 
in red with previ
calculates measu
locations; which 
the Measure (the
Locations display
cursor.

 Clear . . . . . . . . . . . . . . . . . . . . . . . . clears the column

 Copy . . . . . . . . . . . . . . . . . . . . . . . . copies the colum
clipboard, for us
clipboard.

 Save. . . . . . . . . . . . . . . . . . . . . . . . . saves the history
specified scatter
Demo 3D Viewe
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Options Tab

e 3D cursor are shown as scaled lines, in 
hite line segments and the Demo 3D 
ent length that varies automatically as the 

No matter how far in or out the view is, the 
 a reasonable number of sections. The line 
anged, however, to user-specified values. 
length is entered, the line segments do not 
oomed. In addition, regardless of how 
Y and Z values also control the intervals 
nge the 3D Cursor location for the sliders 

e 3D cursor is subdivided and/or shaded, 
 cursor

 is displayed around the active 3D cursor. 
ius, expressed in XY units, and will stretch 

 is not 1.  The sphere can be transparent or 
the Transparency checkbox.

wo points or calculate the area of a 
n be calculated between a tops pick and 

Snapping icon button (sixth button on the 
t the 3D Cursor moves to the selected 
ded surface. In the 3D Cursor Dialog 
n adds a second 3D Cursor. In the 3D 
lecting the Measure (i.e., the green ruler) 

tance between the two cursor locations in 

s
at they form a triangle. Selecting the 
nnecting the three 3D cursor locations, and 
3D Viewer EarthVision 6.0

The following controls are on the Options tab:

 Scalebar Interval. . . . . . . . by default, the axes of th
alternating colored and w
Viewer selects a line segm
view is zoomed in or out. 
scalebars are divided into
segment length can be ch
When a specific interval 
change when the view is z
these values are set, the X
that the arrow buttons cha
on the Location tab.

 Cursor Object  . . . . . . . . . . controls whether the activ
and the pixel width of the

 Cursor Sphere . . . . . . . . . . controls whether a sphere
The sphere is constant rad
when the Z-exaggeration
opaque, as controlled by 

Measure Using Two 3D Cursors
One of the functions of the 3D Cursor is to measure between t
triangle between three points. For example, a measurement ca
the surface grid. This can be done by selecting the 3D Cursor 
top tool bar), clicking anywhere on the grid surface; notice tha
point. You can also click and drag the 3D Cursor over the grid
window, selecting the Add button in the 3D Cursor Marks sectio
Cursor dialog, setting the Mode combo box to Measure then se
icon buttons for both Cursor 1 and Cursor 2, calculates the dis
data scale units, along with the plunge and bearing.

Calculate Area Using Three 3D Cursor
Area can be calculated between three 3D cursors, provided th
Measure (green ruler) icon button displays a yellow triangle co
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the plane dip, plane dip-azimuth, and area are calculated and displayed near the bottom of the 3D 
Cursor Dialog window.

, Z location of each 3D cursor near the 
urrent History of Scattered Data Locations 

 the 3D cursor locations.

ves the 3D cursor to the location the user 
ered data point (without turning on snap-
hich is the hot key for the Snap to Last 

, say that a proposed well is displayed 
 “snap”—a proposed well location to the 
 Z plane on which an image is displayed).

eters. This icon button functions the same 
 information.

ces an Axes Dialog window, shown below, 
ark reference and intervals, and captions. 

he rendering of the wireframe measure-
 more information.
54 EarthVision 6.0 2

Setting the Mode to Current Locations displays the current X, Y
bottom of the window. Selecting the bottom icon button, Save C
to Scattered Data File, creates a scattered data file containing

3D Cursor Snapping
Selecting the 3D Cursor Snapping icon button immediately mo
clicks on. An additional way of snapping the cursor to a scatt
to-surface) is to first pick a point, then press the J hot key, w
Picked Point function.

The 3D Cursor can also be snapped to a surface. For example
with a surface or set of surfaces, it is often useful to move—or
closest surface or location on an image plane (i.e., the X, Y, or

Set Lighting
The Set Lighting icon button is used to specify lighting param
way as selecting View –> Lighting. Refer to Lighting for more

Set Axes, Labels, and Captions
Selecting the Set Axes, Labels, and Captions icon button produ
that is used to specify details for axes posting, labeling, tickm
The Lattice tab on the same interface provides control over t
ment lattice. Refer to the View –> Axes and Labels section for
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; each of these forms indicates a different 
 shape of a hand or left-slanting arrow. 

e, this pointer is used for scattered data 
reen annotation, and user input. The tab 
er between the Select and Manipulate 

 mode, this cursor is used to rotate, zoom, 
 3D Cursor, and to slice along the X, Y, or Z 
3D Viewer EarthVision 6.0

Demo 3D Viewer Mouse Pointer
The Demo 3D Viewer mouse pointer can take on several forms
state or mode to the user. Most of the time, the pointer is in the
Each of the shapes are described below:

 Left-slanting arrow  . . . . . . referred to as Select mod
picking, snap to object, sc
hot key switches the point
modes.

 Hand . . . . . . . . . . . . . . . . . referred to as Manipulate
and pan, to work with the
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plane. The tab hot key switches the pointer between the Select and 
Manipulate modes.

r is performing the current command or 

button (i.e., Click and Enter Text) is selected 
Text Annotation mode.

con button (i.e., Press and Sweep a Contin-
.

ing Tool is toggled on.

Measure Tool is toggled on.

rrow icon button (i.e., press and sweep a 

rrayed down the left hand edge of the 
 in relation to their control of the mouse 

g upon the current mode. Clicking the 
pointer. This mouse pointer is used for 
. Refer to File Query for more information 

Manipulate mode. The tab hot key alter-
ct or Manipulate mode, the mouse pointer 
 pointer is very near one of the 3D Cursor 

D Cursor will change locations.
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 Hour glass . . . . . . . . . . . . . displayed when the Viewe
loading a file.

 Cross Hairs. . . . . . . . . . . . . appears when the A icon 
and the pointer is in Add 

 Pencil . . . . . . . . . . . . . . . . . appears when the Pencil i
uous Pencil Line) is selected

 Bullseye . . . . . . . . . . . . . . . appears when the Center

 Measuring Tape. . . . . . . . . appears when the Quick 

 Right Pointing Arrow  . . . . . appears when the Right A
3D vector) is selected.

The Mouse Pointer Mode is generally controlled by the icons a
Viewer window. In the sections below these icons are discussed
pointer mode.

Select Mode
In the Demo 3D Viewer, the mouse pointer changes dependin
Select Mode icon button produces a left-facing arrow mouse 
scattered data picking, snapping to an object, and user input
on querying files when using Select mode.

Controls in the Panel can be selected in either Select mode or 
nates between the Select and Manipulate modes. In either Sele
shape changes to an arrow with a small + sign when the mouse
axes. This lets the user know that if they then click down, the 3



57

Manipulate Mode
 or a hand. Selecting the Manipulate Mode 
te, zoom, and pan, to work with the 3D 
ey alternates between the Select and 

hanges to an arrow with a small + sign 
s. This lets the user know that if they then 

eation and editing of screen annotation 
notation is saved to a vue file when a vue 

n Edit icon button. When in Annotation Edit 
e, and the mouse pointer varies between 
dit.

tically along the side of the Model window:

 Vector icon button creates a 2D vector, 
 the end of the vector. The left mouse 
 press and sweep a 2D vector. When the 
utton is active, a Pixels pull-down menu 
) appears along the horizontal toolbar of 
w.

t icon button creates text in the Model 
 left mouse button in the window to locate 
econd time and begin typing the desired 
 Return key adds another line of text. 
 mouse elsewhere in the Model window, or 
s more text in the selected location. When 
ton is active, the controls (discussed below) 
e horizontal toolbar of the Model window.

tinuous Pencil Line icon button creates a 
he left mouse button is used to press and 
3D Viewer EarthVision 6.0

In the Demo 3D Viewer, the cursor is either a left facing arrow
icon button produces a hand cursor. This cursor is used to rota
Cursor, and to slice along the X, Y, or Z plane. The tab hot k
Manipulate modes.

In either Manipulate or Select mode, the mouse pointer shape c
when the mouse pointer is very near one of the 3D Cursor axe
click down, the 3D Cursor will change locations.

Screen Annotation Edit
Selecting the Screen Annotation Edit icon button allows the cr
such as text, vectors, and pencil lines. If displayed, screen an
file is saved.

To select or edit screen annotation, select the Screen Annotatio
mode, the icons on the vertical and horizontal tool bars chang
four modes: vector, text, pencil, and screen annotation move/e

The following screen annotation icon buttons are arranged ver

 2D Vector  . . . . . . . . . . . . . . . . . . . . selecting the 2D
with an arrow at
button is used to
2D Vector icon b
(discussed below
the Model windo

 Text . . . . . . . . . . . . . . . . . . . . . . . . . selecting the Tex
window. Click the
the text; click a s
text. Pressing the
Clicking with the
on a button add
the Text icon but
appear along th

 Continuous Pencil Line  . . . . . . . . . . . selecting the Con
continuous line. T
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draw the continuous line, then release the left mouse button 
to end the line. When the Continuous Pencil Line icon button 

own menu (discussed below) appears 
ntal toolbar of the Model window to 
 width of the pencil line.

ete and Move Annotation icon button either 
ted screen annotation or moves it from one 
er. To delete screen annotation, first select 
ove Annotation icon button, then use the 
 to select the annotation, and click the 
 keyboard. To move screen annotation, 
lete and Move Annotation icon button, then 
r over the annotation, press and hold the 
, drag the annotation to its new location, 
mouse button.

ain Annotation After View Change icon 
ymbol) locks the screen annotation in 
en the model is manipulated (e.g., rotate, 
nnotation stays in the same place. 
een annotation causes the annotation to 
ever the model is manipulated. Screen 
cked by default.

ar Any Screen Annotation icon button 
ntly displayed screen annotation.

izontally along the top of the Model 

or Palette icon button produces a color 
 basic colors can be selected or custom 
 color is selected for the next annotation 

he default color is white/black. The Color 
ailable for all screen annotation types.

wn menu specifies the pixel width of 
n vectors and pencil lines. The range is 1 to 
ault is 2 pixels. The Pixels menu is avail-
and pencil lines.
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is active, a pull-d
along the horizo
specify the pixel

 Delete and Move Annotation. . . . . . selecting the Del
deletes the selec
location to anoth
the Delete and M
left mouse button
Delete key on the
first select the De
position the curso
left mouse button
and release the 

 Lock icon/Retain Annotation  . . . . . . selecting the Ret
button (the lock s
place, so that wh
zoom/pan) the a
Unlocking the scr
disappear when
annotation is unlo

 Clear Any Screen Annotation  . . . . . selecting the Cle
removes all curre

The following screen annotation icon buttons are arranged hor
window:

 Color Palette . . . . . . . . . . . . . . . . . . selecting the Col
window in which
colors blended. A
to be created. T
Palette icon is av

 Pixels . . . . . . . . . . . . . . . . . . . . . . . . the Pixels pull-do
screen annotatio
5 pixels; the def
able for vectors 
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 Font Type. . . . . . . . . . . . . . . . . . . . . sets the font type for the text that is created. The available 
fonts are: Arial (the default), Courier New, Century School-

 New Roman. This item only appears when 
ated. The font types available on Linux 
efault), Courier, New Century Schoolbook, 
Roman.

 for the text that is created. The available 
, 10, 12, 14, 16, 18, 20, 24, and 32. This 
rs when text is being created. The font 
n Linux are 8, 10, 12, 14, 18, and 24.

 text that is created should be plain text 
old, italic, and/or underlined. These items 

en text is being created.

face or point centers the look point (the 
) on that surface or point. By default, the 
, Y, and Z axes). The look point is always 

location within the model.

 model. It is especially useful when a user 
 of interest is near an outer edge, as the 
pear off the screen. Moving the look point 
r of the screen.

licking on the Reset Look Point (home) icon 

 to the default settings.
3D Viewer EarthVision 6.0

book, and Times
text is being cre
are: Helvetica (d
and Times New 

 Font Size . . . . . . . . . . . . . . . . . . . . . sets the font size
font sizes are: 8
item only appea
sizes available o

 Bold, Italic, and Underline. . . . . . . . sets whether the
(the default) or b
only appear wh

Centering Tool
Selecting the Centering Tool icon button then clicking on a sur
X,Y,Z location that is used as the rotation point for the model
look point is at the center of the model (half-way along the X
placed in the middle of the Model window, regardless of its 

Changing the look point results in essentially a panning of the
wants to zoom in on particular area. For example, if the area
zoom distance is decreased (zooming in), the area may disap
closer to the area of interest repositions that area to the cente

The look point can be returned to the center of the model by c
button near the Pan thumbwheels.

Reset View
Selecting the Reset View icon button resets the Model window
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Magnifier Tool
 the mouse cursor; clicking the mouse cursor 
fier window can be moved about the 
button. Placing the left mouse button on the 
decreases the magnified region. The 
 to zoom in or out. The magnifier can be 
e right mouse button to bring up a pop-up 

gles the color of the background between 
g on the Reverse Background Black/White 
ound color changes, the color of the axes 

tween the two types of projection avail-
 or an orthographic projection. By default, 

stic because objects that are farther away 
s of the wire frame (the axes), although 

 behind the model.

n is used. This projection draws all objects 
ance from the eye point. In this case, the 
en.
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Selecting the Magnifier Tool icon button changes the shape of
in the Model window turns on a magnifying glass. The magni
Model window by dragging the window using the left mouse 
edge of the magnifier window and dragging it, increases or 
magnification can be changed using the middle mouse button
turned off either via the Magnifier Tool icon button or using th
menu.

Reverse Background Black/White
Selecting the Reverse Background Black/White icon button tog
black and white. Holding down the Ctrl key while left-clickin
icon button cycles through five shades of gray. As the backgr
lines, ticks, and labels change as well.

Perspective/Orthographic
Selecting the Perspective/Orthographic icon button toggles be
able for viewing the current display: a perspective projection
the model is displayed with the perspective projection.

The perspective projection causes the model to look more reali
appear smaller than objects that are closer. The “parallel” line
they appear parallel, actually converge at some distant point

When the perspective projection is off, orthographic projectio
of the same dimensions at the same size regardless of the dist
“parallel” lines of the wire frame are truly parallel on the scre
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Inclination
mouse button, rolling it down rotates the 
n. This has the same effect as typing the 
 up rotates the top face of the model up, 
 typing the up arrow key on the keyboard. 
g forward, and an inclination of -90 faces 
 specific value by clicking with the left 
ping in the new, desired inclination. The 
ent for the thumbwheel is 0.5. The default 

ouse button, rolling it to the left decreases 
ing down from above the model. It has the 
he thumbwheel to the right rotates the 
ve the model). It has the same effect as the 
 specific value by clicking with the left 

l and typing in the desired value. The 
ent for the thumbwheel is 0.5. The default 

he Ctrl key causes continuous, autono-
ain stops the continuous rotation.

the inclination and the azimuth to the 

he display into orthographic map view, 
ift key is held down while selecting the 
taining the map view.
3D Viewer EarthVision 6.0

Pressing and holding the Inclination thumbwheel with the left 
top face of the model down, thereby increasing the inclinatio
down arrow button on the keyboard. Rolling the thumbwheel
thereby decreasing the inclination. This has the same effect as
When the inclination equals 90, the maximum Z-plane is facin
the minimum Z-plane forward. The inclination can be set to a
mouse button on the value box below the thumbwheel and ty
smallest increment for the value box is 0.1. The smallest increm
inclination is 35.

Azimuth
Pressing and holding the Azimuth thumbwheel with the left m
the azimuth, rotating the model to the left or clockwise if look
same effect as the left arrow key on the keyboard. Moving t
model counter-clockwise (again while looking down from abo
right arrow key on the keyboard. The azimuth can be set to a
mouse button on the value box to the right of the thumbwhee
smallest increment for the value box is 0.1. The smallest increm
azimuth is 65. Using the Azimuth thumbwheel while pressing t
mous azimuthal rotation. Clicking the Azimuth thumbwheel ag

Reset Inclination and Azimuth
Selecting the Reset Inclination and Azimuth icon button resets 
default values of 35 and 65, respectively.

X/Y Map View
Selecting the green X/Y Map View icon button manipulates t
oriented with North up. Mouse rotation is disabled. If the Sh
green X/Y Map View icon button, a new window pops up con
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X/Y, X/Z, and Y/Z Plan Views
lay so that the maximum X/Y plane is 
ipulates the display so that the maximum 
 button manipulates the display so that the 
lination and Azimuth icon button resets the 

is held down while selecting a plan view 
 The zoom/pan can be reset by holding 
.

rtical- or Z-exaggeration from the default 
n text box, is automatically calculated by 
 cube. If the model contains mixed units 
 3D Viewer adjusts the Z exaggeration 
 range is 1 meter, a Z-exaggeration of 1 
times longer than the 1-foot side.

n value box to either stretch or flatten the 
n by a factor of 1.25 (S hot key, for 
exaggeration by a factor of 1.25 (D hot 
ing to the X/Y scaling is shown in the Z 

aggeration to the default setting.
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Selecting the X/Y Plan View icon button manipulates the disp
facing forward. Selecting the X/Z Plan View icon button man
X/Z plane is facing forward. Selecting the Y/Z Plan View icon
maximum Y/Z plane is facing forward. Selecting the Reset Inc
inclination and the azimuth to the defaults. If the Shift key 
icon button, a new window pops up containing the plan view.
down the Ctrl button and clicking with the left mouse button

Z Exaggeration
The controls shown to the left are available to change the ve
value. The default value, which appears in the Z exaggeratio
the Demo 3D Viewer to give a reasonable display, close to a
(e.g., if the XY units are feet and the Z units meter), the Demo
accordingly. For example, if the XY range is 1 foot and the Z
would make the 1- meter side appear approximately three 

A Z exaggeration value can be entered in the Z Exaggeratio
model. The up arrow icon button increases the Z-exaggeratio
“stretch”), while the down arrow icon button decreases the Z-
key, for “de-stretch” or flatten). The actual ratio of the Z scal
Exaggeration value box.

Reset Z Exaggeration
Selecting the Reset Z Exaggeration icon button resets the Z ex
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Lock Z Exaggeration
hat any changes to the Model window that 
 it.

sition along the line of sight. Zooming in 
odel becoming larger on the screen. 
d closer to the model, the axes’ labels are 
the model becomes larger than the screen, 
ell as all other functions, are always avail-
r.

e button, rolling it up zooms the model out, 
s typing the hot key O. Moving the thumb-
ing the hot key I.

d 15% of the current distance closer to the 
 can be changed; refer to Set Look Point to 
gh it is the same percentage amount. Thus, 
k point or center. The Zoom Out hot key O 
del’s look point each time.

 (this can be turned off; refer to Perspec-
e eyepoint moves closer to the model, the 
erspective. The visual effect is the same as 

ion: the location of interest may disappear 
ork in a backwards manner.

del window, using the Centering Tool icon 
 the lookpoint and the rotation point to the 
terest, all zooming and rotation is centered 
details on this feature.
3D Viewer EarthVision 6.0

Selecting the Lock icon button “locks” the Z exaggeration so t
would normally change the Z exaggeration would not affect

Zoom
The zoom function has the effect of changing the viewer’s po
moves the eyepoint closer to the look point, resulting in the m
Zooming out has the opposite effect. As the eyepoint is move
turned off as they can become significantly distorted. When 
it is truncated at the screen limits. The rotation functions, as w
able even when zoomed in very close or zoomed out very fa

Pressing and holding the Zoom thumbwheel with the left mous
moving it farther away from the user. It has the same effect a
wheel down zooms the model in. It has the same effect as typ

Each time the Zoom In hot key I is typed, the eyepoint is move
look point, which, by default, is the model center (although this
3D Cursor). Each inward move covers a smaller distance, althou
the eyepoint can approach, but not move onto the model’s loo
moves approximately 18% of the distance away from the mo

Since property models are generally displayed in perspective
tive/Orthographic) parallel lines converge front to back. As th
angle of convergence increases consistently with the rules of p
moving a zoom lens from a wide-angle to a telephoto setting.

Rotation While Zoomed In
Two issues may occur when rotating while zoomed in on a locat
outside of the Model window or the rotation may appear to w

If the location you are interested in disappears outside the Mo
button can be very useful. This function, described earlier, sets
selected spot. Once the lookpoint is moved to the location of in
around the desired location. Refer to Centering Tool for more 
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When viewing a model from a very close viewpoint, the rotation commands may seem as though they are 
working in a reversed manner. This occurs when most of the visible portion of the model is behind the look 

 always applies to the part of the model in 

 addition, sometimes a portion of a model 
mstances using the right mouse button to 
 desired area. Alternatively, the Centering 
esired area. Refer to Centering Tool for 

heel control to its default setting.
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point because the direction indicated by the rotation command
front of the look (pivot) point.

Zoom In on an Exact Location
Sometimes it is desirable to zoom in on a particular location. In
moves off the screen while zooming. Under both of these circu
pan and the middle mouse to zoom allows the user to view the
Tool icon button can be used to change the look point to the d
more details on this feature.

Reset Zoom
Selecting the Reset Zoom icon button resets the Zoom thumbw
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Pan
el with the left mouse button, moving the 
ple, rolling the vertical thumbwheel up 
lling the horizontal thumbwheel left moves 
 the right.

odel is in the middle of the screen using the 
d.

e held down for manipulation; when in 
be used.

isplay screen. Moving the mouse pointer 
ection as the mouse pointer (e.g., moving 
to the right and up). Changing the look 

hich mouse button is pressed shifts from 
y of the others without having a redraw 
drawn until the Ctrl or Shift key is 
 to make panning comfortable, the mouse 
ursor repositioned on the mouse pad, the 
ntrols also make it very easy to view an 

e Pan thumbwheels to their default settings.
3D Viewer EarthVision 6.0

Pressing and holding the horizontal or vertical Pan thumbwhe
thumbwheel moves the model in the same direction. For exam
moves the model up, rolling it down moves the model down, ro
the model to the left, and moving it right moves the model to

The look point can be changed such that any portion of the m
right mouse button and either the Ctrl or Shift key presse

Note: When in Select mode, the Ctrl or Shift keys may b
Manipulate mode, the Ctrl or Shift keys need not 

The mouse pointer can be anywhere in the Demo 3D Viewer d
moves the model in the XY plane of the screen in the same dir
the mouse pointer towards the right and up, moves the model 
point has the effect of panning along the model.

Keeping either key (Ctrl or Shift) pressed and changing w
changing the look point to zooming to rotation and back to an
occur with each change. In addition, since the display is not re
released, if the cursor gets too close to the edge of the screen
button can be released (without releasing the other key), the c
mouse button re-pressed, and the panning continued. These co
exact location.

Reset Lookpoint
Selecting the Reset Lookpoint (i.e., home) icon button resets th
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Demo 3D Viewer Panel Window
V Panel), which appears to the right of the 
nts. Each of these is discussed below:

he File Selection pane in the order in which 
 the active file; by default, it is the first file 
ne controls which files are visible and 
bbed menu only apply to the active file(s). 
in the File Selection pane. To select more 
le clicking on the desired file names.

play controls that only apply to the active 

x to the left of the file name. Hiding a file 
is still in memory, it is simply not displayed. 
box underneath the File Selection pane.

eatedly when dragging a slider handle. If 
endering can be disabled by selecting the 
f the Visible checkbox.

d file with a single, solid color. For 
locks, each a unique color. Selecting the 
 return the faces file display to numerous 
 tab).
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The Demo 3D Viewer Panel window (also referred to as the 3D
Demo 3D Viewer Model window, contains five major compone

 File Selection pane

 Slice tab

 Visible tab

 Render tab

 Edit tab

File Selection Pane

Every file loaded into the Demo 3D Viewer is listed in t
they were loaded. The highlighted file name indicates
loaded into the Demo 3D Viewer. The File Selection pa
which file (or files) is “active”; changes made on any ta
To select a different file, simply click on the file name 
than one file, hold down the Shift or Ctrl key whi

The tabbed windows below the File Selection pane dis
(highlighted) files.

Each file can be displayed or hidden using the checkbo
does not remove it from the Demo 3D Viewer; the file 
All files can be turned on or off using the Visible check

The default is to render the model scene rep
rendering performance is slow, immediate r
Immediate Render push button, to the right o

Selecting the Paint Bucket icon button colors the selecte
example, a faces file might have horizons and fault b
paint bucket icon colors the faces file a singe color (to
colors, use the Attribute Visibility settings on the Visible
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Selecting the Solid Color icon button produces a color palette window displaying the available basic 
colors; a custom color can also be created. A color can be selected for the solid color that is used when 

 pop-up menu with the following options:

cted file(s) from the Demo 3D Viewer. If 
 to a file that have not yet been saved, a 

whether to save the edits before unloading 

 the Demo 3D Viewer; removes file(s) from 
groups, and deselects Make Z Units 

lected file(s) in the same space. The 
 the duplicated file names have numbers 
1, 2, etc.) where 1 is the original file, 2 is 
would be another duplicate, etc.

 snippet” for the selected file. The vue file 
 and then automatically loaded whenever 
is loaded. This allows visibility and attri-
 a particular file to be maintained, even 
pecific vue file. For example, a specific 
ile can default to being colored by P.

ook tabs can be dragged up or down 
p/down icon when the mouse pointer is in 
ngthens the File Selection box and hence 
 Edit –> Preferences to set the Pane Layout.
3D Viewer EarthVision 6.0

the Paint Bucket icon is selected.

Right Clicking in the File Selection Pane
Right clicking on any file in the File Selection pane produces a

 Unload File(s) from Viewer . . . . . . . removes the sele
edits were made
prompt inquires 
the file.

 Reload File(s) to Viewer  . . . . . . . . . reloads files into
visibility cycling 
Unknown.

 Duplicate File(s) . . . . . . . . . . . . . . . . duplicates the se
original file and
appended (i.e., 
the duplicate, 3 

 Vue Snippet. . . . . . . . . . . . . . . . . . . .saves a “vue file
snippet is saved
the selected file 
bute settings for
without using a s
property data f

Changing the File Selection Pane Size
The sash that separates the File Selection pane from the noteb
using the left mouse button. The mouse pointer changes to an u
the correct position to make this adjustment. This shortens or le
the number of files that are displayed in the list box. Also see



002 Dynamic Graphics, Inc. All Rights Reserved.

Slice Tab

ich is discussed below:

splay.

 into the model or display.
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The Slice tab is divided into the following sections; each of wh

• Boundary Slicing . . . . . . . . slices into the model or di

• Slice Animation  . . . . . . . . . used to animate the slicing



69

Boundary Slicing
wing controls to slice into a model or 

the slider bars and the Reset Slider Settings 
 right of each slider bar. The slider bars 
ted using the handle(s) on the bar, the 
th the bar, or by entering a minimum and 

for the handle in the text boxes below the 

the slider bars available when a 3D 
e active file. The sliders work the same 
and Z sliders do, but remove cells along 
ction.

ey) resets all slices, including the chair 
e full extent of the model (chair mode 
chair slices return to their default position). 
as been extensively cut, it is quicker to use 
es function (located beneath the last of the 
restore each of the cut faces than to reset 
l individually using the Reset Slider Settings 
slider bar.

Along Axes checkbox on enables direct 
 of the 3D axes by clicking and dragging 
del axes turn yellow and purple drag 
ed on the model axes. The purple slice 
ressed and dragged to change slicing 
 interactively within the Model window. 
xes does not operate on cell grids.

to the 3D cursor location (hot key Ctrl+K). 
 3D Cursor icon button displays the 3D 
rsor is then moved to whatever location the 
e. Then, selecting one of the Slice to Cursor 
 Front X Slice to Cursor, Front Y Slice to 
 Slice to Cursor) slices that front plane to 
ation. The Slice to Cursor function does not 
rids.
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 The Boundary Slicing section of the Slice tab contains the follo
display:

 X-, Y-, and Z-axis Slicing. . . . . . . . . controlled using 
icon button to the
can be manipula
arrows undernea
maximum value 
bar.

 i-, j-, and k-Direction Slicing  . . . . . . controlled using 
cellular grid is th
way as the X, Y, 
the desired dire

 Reset All Slices. . . . . . . . . . . . . . . . . (or the End hot k
slices, back to th
stays on, but the 
When a model h
the Reset All Slic
three sliders) to 
each slice contro
button for each 

 Slice Along Axes . . . . . . . . . . . . . . . setting the Slice 
slicing along any
the slice. The mo
controls are plac
controls can be p
immediately and
The Slice Along A

 Slice to Cursor . . . . . . . . . . . . . . . . . slices the model 
First, clicking the
cursor. The 3D cu
user wants to slic
icon buttons (i.e.,
Cursor, or Front Z
the 3D cursor loc
operate on cell g
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• Chair Mode . . . . . . . . . . . . . . . . . . . (or the Insert hot key) removes a subsection of the model 
at the corner nearest the viewer’s eye. The amount 

ghth of the portion of the model shown) is 
e current X, Y, and Z slicing positions (front 
chair slices come up halfway between 
nt minimum and maximum slicing planes 

elow). The Chair Mode function does not 
rids.

uth and/or inclination is changed while 
r subsection that is removed remains the 
ngle; this is known as having the Chair Lock 
ly, the chair subsection can change such 

 the user’s eye is removed as the rotation 
 words, the portion of the model that is the 
uth and/or inclination is changed, but it is 
to the user. Freezing the chair subsection in 
er selecting the Chair Lock icon button or 

d file. Multiple files can be selected by 
e File Selection pane. A series of files can 
 and last files in the series; the first file, the 

 On
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removed (one-ei
determined by th
and back)—the 
each of the curre
(see diagrams b
operate on cell g

• Chair Lock . . . . . . . . . . . . . By default, when the azim
chair mode is on, the chai
same, regardless of the a
icon button on. Alternative
that the portion closest to
angle is changed. In other
chair changes as the azim
always the section closest 
place is activated by eith
the slash (/) hot key.

Slider Handle and Value Manipulation
When a single file is selected, slicing only occurs on the selecte
pressing the control button while selecting multiple files from th
be selected by pressing the shift button while selecting the first
last file, and all files in between are automatically selected.

Chair Mode Off Chair Mode
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The handle position can be moved directly to a location, by clicking the cursor at the new position desired 
for the handle. The handle closest to the cursor position then moves immediately to the place where the 

tton is not released, the handle is “tied” to 
 In this way, the cursor does not need to be 
ith two or three handles, care should be 

gs can be changed incrementally by 
arrow moves the corresponding handle to 
can also be entered directly for the setting 
the bar. (Clicking on the left box changes 
e right box changes the right handle; and 
air Mode.) If the user enters a value that is 
ilable value.
3D Viewer EarthVision 6.0

mouse button was clicked. If, after pressing down, the mouse bu
the position of the cursor and can be dragged to any position.
placed directly on the handle in order to move the handle. W
taken to place the cursor closest to the handle to be moved.

Value Boxes and Arrows
Three other methods exist for changing a slider bar. The settin
clicking on the arrows below the box(es). Clicking on the right 
the right; clicking on the left arrow moves it to the left. A value 
by clicking with the left mouse button on the value box below 
the value for and the position of the left handle; clicking on th
similarly for the middle box and middle handle when using Ch
not available, the Demo 3D Viewer rounds to the nearest ava
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Linked Scattered Data Point Slicing
ath, .pdat files) with other files (.faces) is 

 linked by selecting the scattered data file 
nked Slicing section on the Slice tab, as 
72 EarthVision 6.0 2

Simultaneous (linked) slicing of scattered data files (i.e. .dat, .p
available by linking these different files together. Files can be
and choosing the file to link to using the pull-down list in the Li
shown below.
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Once linked slicing has been enabled, both files must be selected in the File Selection tree to get linked 
slicing. Linked files can optionally be sliced using an offset distance entered in the boxes under the Linked 

nce between the slicing location of the two 
are allowed. The defaults for these offsets 
g an offset can be extremely useful when 
 scattered data file, for example.

 file or 3D grid (but not 3D cellular grids) 
s also used to cycle through time in a data 
anar direction can be animated at a time.

still functional. These hot keys include the 
 zoom out), the Ctrl+arrow keys (for 
ion, zooming, and panning).

hich attribute is used for animation.The 
d Z (or I, J, K, and None in the case of 
he combo box selects which set of planar 
or the animation. Once the axis is selected, 
pear on the selected axis’s slider bar. The 
e of the animation while the slider bars 
idth of the “slice” to be animated. The 
l portion along the length of the selected 
 arrows. In order for the animation to be 
andles must be set to a smaller portion of 
 green arrows.
3D Viewer EarthVision 6.0

Slicing section on the Slice tab. The offset distance is the dista
files. Different horizontal (XY) and vertical (Z) offset distances 
is zero (i.e. both files are sliced to the same location). Applyin
QC’ing a faces file structural model against the relevant input

Slice Animation
Animation involves cycling through the planar slices of a faces
one at a time along any single user-specified axis. Animation i
set that contains temporal (recurrent) information. Only one pl

During the animation, the rotate, zoom, and pan hot keys are 
arrow keys (for rotation), the I and O keys (for zoom in and
panning), and the Ctrl/Shift+ mouse button keys (for rotat

The following controls are on the Slice Animation section:

 Attribute  . . . . . . . . . . . . . . This combo box controls w
choices are None, X, Y, an
recurrent cellular grids). T
slices are cycled through f
a set of green arrows ap
green arrows set the rang
regular handles set the w
animation moves this smal
axis defined by the green
effective, the slider bars h
the total range set by the
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 Mode . . . . . . . . . . . . . . . . . The Loop and Swing radio buttons control what happens when the 
animation reaches the end of the planar slice’s range. Loop repeats 

 direction, starting back at the beginning 
t) slice is reached (depending on the Front 
next). Swing reverses the direction when 
 end.

x specifies whether the animation moves 
 the eye point (Front to Back is on (i.e., 
away from the eye point (Front to Back is 

 specify the minimum amount of time (in 
ains on the screen. The default is 0.2 

e Time to 0 allows the animation to run as 

tton (right-facing arrow) plays or starts the 

tton (black square) stops the animation.

utton (double vertical bars) pauses the 
animation when already in Pause mode.

button (vertical bar with two left-facing 
tion to the beginning frame.

 icon button (two arrows with a vertical 
imation to the final frame.

lly using the corresponding Visible check-
ns can be moved using the slider bars. As 
ediately displayed in the Model window, 
74 EarthVision 6.0 2

the animation in the same
(or end) after the last (firs
to Back setting, discussed 
the animation reaches the

 Initial . . . . . . . . . . . . . . . . . The Front to Back checkbo
the sliced portion towards
checked), the default) or 
off).

 Frame Time . . . . . . . . . . . . The Frame Time is used to
seconds) each display rem
seconds. Setting the Fram
quickly as possible.

 Play . . . . . . . . . . . . . . . . . . Selecting the Play icon bu
animation.

 Stop . . . . . . . . . . . . . . . . . . Selecting the Stop icon bu

 Pause . . . . . . . . . . . . . . . . . Selecting the Pause icon b
animation, or restarts the 

 Rewind . . . . . . . . . . . . . . . . Selecting the Rewind icon 
arrows) rewinds the anima

 Fast Forward . . . . . . . . . . . Selecting the Fast Forward
bar) fast forwards the an

Planar Slicing
The X, Y, and Z planar slices can each be turned off individua
boxes, or all at once using the All checkbox. The plane locatio
the Planar Slices slider bars are modified, the changes are imm
allowing for rapid reconnaissance through seismic volumes.
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Visible Tab

at portions of the active model, grid, or 
e, a particular fault block or zone could be 
alue can be made invisible. Controls are 
 attributes. 

ttribute types as they are handled in 

 or any non-numeric field, and is always 
xes that are used to control the feature’s 

 property, and is always represented with 

available discrete and numeric attributes 
 attributes are displayed in the remainder 
 of checkboxes—one column for each 
that attribute. At the bottom of the tab are 
f the selected file has no attributes, the 
d these three sections (the lists and the two 
3D Viewer EarthVision 6.0

The Visible tab controls, on an attribute-by-attribute basis, wh
data set are displayed and how they are colored. For exampl
turned on or off, or those portions above a certain property v
also available to color data based on the values of any of its

It is important to understand the difference between the two a
different ways:

 Discrete Attribute. . . . . . . . is any numerically discrete
represented with checkbo
visibility.

 Numeric Attribute  . . . . . . . is any continuously varying
a slider bar.

At the top of the Visible tab are two columns listing all of the 
for the currently active file—these lists are used to filter which
of the Visible tab. Below the two lists of attributes are columns
Discrete Attribute and one checkbox for each unique value of 
horizontally arrayed sliders, one for each Numeric Attribute. I
controls on this tab remain blank. The icons and controls aroun
sets of attributes controls), are detailed below.
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Discrete and Numeric Filter Lists
ric Attributes in the currently active file (as 
are highlighted, and hence all the attri-
ctions in the Visible tab. By deselecting or 
removed or added to the Discrete and 
 dozens or hundreds of attributes in a 
ht have over one hundred numeric attri-
uickly find the attribute of interest.

rol the appearance of the attribute lists, as 

ttributes on the list of Discrete or Numeric 

 discrete attribute checkbox list or the 
mporal component are shown in the attri-

ete Filters making all attribute values 
 any of the attributes have been turned 
 attributes visible again.

e Numeric Filters making all attribute 
alues in any of the attributes have been 
 numeric attributes visible again.

checkboxes, with one checkbox for each 
kboxes to off turns off the visibility of all 
ls with wellid of the deselected value). The 
ute alone, and are described here:
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These two lists contain the names of all the Discrete and Nume
selected in the File Selection list). By default, all the attributes 
butes are represented in the Discrete and Numeric Attribute se
reselecting the different attribute names, those attributes are 
Numeric Attributes lists. This is a useful process when there are
single file (for example a typical reservoir simulation grid mig
butes), and hence by deselecting most attributes the user can q

Attached to the attribute lists are several icon buttons that cont
described below:

Selecting the Funnel icon button selects (or deselects) all the a
Filters.

Selecting the Temporal Attributes icon button filters either the
numeric attribute slider list such that only attributes with a te
bute lists.

Selecting the Reset All Discrete icon button resets all the Discr
visible. In other words, if the visibilities of any of the values in
off, then selecting this icon will make all values of all discrete

Selecting the Reset All Numeric Filters icon button resets all th
values visible. In other words, if the visibilities of any of the v
filtered off, then selecting this icon will make all values of all

Discrete Attributes
Each Discrete attribute is represented by a vertical column of 
unique value of that attribute. Setting the toggle buttons/chec
elements of that attribute value (for example, turns off all wel
tools below each discrete attribute column apply to that attrib
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The Discrete Attribute Text Filter box provides an easy way to shorten the list of Discrete Attribute check-
boxes. The list of values for the given attribute are filtered based on the string typed into the text filter 

 only the attribute values containing the 
he X icon button next to the text filter box 
Note, that there are sometimes many 
 hence the list of checkboxes can become 
. A limit on the total number of checkboxes 
 settings.

 of all the values for the given attribute, 

ings of the given attribute; any values set 

n the values of the selected attribute.

rop-down menu. The file palette drop-
 the following functions:

t colors. Depending on the file this could be 
zone color table, faultblock color table or 
le. Other color tables can be specified by 
t function, Load Custom Colors, discussed 

cified color file from the file directory. A 
are also supplied with the Demo 3D 
.

e type of discrete attribute, the following 
bles may be available:

lors

ck colors

lors

 colors
3D Viewer EarthVision 6.0

box. For example, if the letter A is entered into the box, then
letter A are displayed in the Discrete Attribute checkbox list. T
resets the filter and makes all attribute values visible again. 
thousands of unique values within any discrete attribute, and
extremely long, and take a very long time to render onscreen
visible at any one time is provided in the Viewer Preferences

Selecting the Reset All Discrete icon button resets the visibility
making all values of that attribute visible.

Selecting the Reverse button reverses the current visibility sett
to on are turned off and vice versa.

Selecting the Color button colors the entire data set based o

Further color controls are accessed by using the file palette d
down menu for discrete attributes, shown to the left, contains

 Load Default Colors  . . . . . . . . . . . . loads the defaul
the DGI default 
feature color tab
selecting the nex
next.

 Load Color File . . . . . . . . . . . . . . . . loads a user-spe
set of color files 
Viewer software

Depending on th
discrete color ta

zone co

faultblo

label co

feature



002 Dynamic Graphics, Inc. All Rights Reserved.

Numeric Attributes
ers—one for each selected numeric attri-
lored by one of its numeric attributes, the 
ute that is colored, select the desired attri-
ket) icon button. The small colored handles 
to either define and limit the range over 
ribute, or both. These functions are 
buttons that relate to that specific numeric 

 the numeric attribute slider bar such that 

e visibility attribute. When used on the 
ing displayed, then selecting the Reverse 
values outside the slider handles become 

n the values of the selected attribute. The 
nction is selected.

wn to the left for numeric attributes. It 

t colors. For most numeric properties this is 
or scheme ranging from red to purple. For 
s the default is a red/white/blue color 
r tables can be specified by selecting the 
d Color File, discussed next.

cified color file from the file directory. A 
are also supplied with the Demo 3D 
. 

er of the colors
78 EarthVision 6.0 2

At the bottom of the Visible tab are a series of horizontal slid
bute in the currently selected file. When a data set is being co
associated property slider is also colored. To change the attrib
bute then select the Apply Colors From This Attribute (paint buc
on the slider bar then become active. These handles are used 
which the attribute is visible, or to remap the colors for the att
described further below, together with additional icon control 
attribute.

Selecting the Reset button resets the handles to the extents of
all values for the given numeric attribute are visible.

Selecting the Reverse button reverses the current setting of th
numeric attribute sliders, if the inner range of the slider is be
icon causes the outer range to become displayed (i.e., those 
visible).

Selecting the Color button colors the entire data set based o
slider bar will take on the colors of the attribute when this fu

Selecting the Color Palette icon button produces the menu sho
contains the following functions:

 Load Default Colors  . . . . . . . . . . . . loads the defaul
a “spectrum” col
Seismic propertie
table. Other colo
next function, Loa

 Load Color File  . . . . . . . . . . . . . . . . loads a user-spe
set of color files 
Viewer software

 Reverse Colors . . . . . . . . . . . . . . . . . reverses the ord
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Selecting the Remap Colors to Slider Handles button redistributes the entire color range to the extents of 
the slider handles. When this mode is enabled, the slider handles are colored red. In this way colors can 

bringing out subtle details in the data that 
ractive fashion, with the colors getting 
er handles. Note that this mode can be 

 (when the modes are used together, the 

time to color a single file. And hence only 
wo exceptions to this rule: firstly, when using 
n, one red, one blue); secondly, when using 
GR’s have a different array of attributes 
 from the LGRs, one from the Root grid, 

numeric attributes that are visible on the 
red blue. The attributes visible on the 
les (unless the reverse mode is toggled on, 
). This mode can be used in an interactive 
user moves the positions of the slider 
e Remap Colors to Slider Handles mode, as 
r handles are colored yellow). In this 
s continuously updated as the yellow slider 
r Handles or the Visibility mode, or both, 
w the numeric attribute slider).

ular grids, can be linked together with the 
he on-screen colors will match between the 
arance for QC purposes, for example.

re displayed in a continuous coloring 
) whereas faces files always have discrete 
represents a range of property values, not 
y data file must adopt discrete coloring. 
3D Viewer EarthVision 6.0

be compressed across a smaller range of numeric values, thus 
might otherwise be indistinct. This mode can be used in an inte
continuously updated as the user moves the positions of the slid
used in conjunction with the Visibility mode, as discussed below
slider handles are colored yellow).

Note: In general, only one attribute can ever be used at one 
one numeric slider at a time will be colored. There are t
Ternary coloring three sliders will be colored (one gree
a cell grid with Local Grid Refinements (LGRs). If the L
relative to the root grid, then multiple attributes (some
perhaps) may used for coloring simultaneously.

Selecting the Visibility button allows control over the range of 
screen. When this mode is selected the slider handles are colo
screen are those in the range between the two blue slider hand
whereupon the values outside the two blue handles are visible
fashion, with the visibility getting continuously updated as the 
handles. Note that this mode can be used in conjunction with th
discussed above (when the modes are used together, the slide
combined mode, the color and the visibility of the attribute get
handles are moved. Note that either the Remap Colors to Slide
are always selected (as denoted by the “pushed-in” icons belo

Linking Property Data Files and 
Property Faces Files in the Viewer

Data files such as property scattered data, 3D grids, and cell
property colortables in a property faces file.  In this manner, t
faces file and the secondary file—ensuring a consistent appe

When data files are loaded into the Viewer their properties a
fashion (each color effectively represents a single unique value
property coloring (one solid color per isoshell where a isoshell 
a single value).  Hence to color-link to a faces file the propert
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To link the files, select the faces file in the File Selection list. On the Visible tab, select the appropriate 
color palette icon for the property to link and choose Link attribute colortables discretely (see image 

n to choose which faces file to link to is 
, non-faces attribute files can link to all 
80 EarthVision 6.0 2

below).

If more than one faces file is loaded into the viewer, the optio
available when the property data file is selected. Additionally
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other non-faces files with continuous property coloring or can be linked to all files plus a faces file using 
discrete rendering. Note that all attribute linking in the Demo 3D Viewer requires that the data files and 

 “Porosity”).

the file selected in the File Selection pane. 
y, symbol display, line display, label 
endix C: Symbols, Line Types, Colors, Fonts, 

ibutes of other file types. Each of these 

s, property isoshell outlines, and faultblock 
d thickness can be changed, or only the 
3D Viewer EarthVision 6.0

the faces files all have the same attribute property name (i.e,

Render Tab

The controls on the Render tab are specific to the file type for 
The controls specify Z contouring parameters, file transparenc
posting, draped image/file display, map pins (discussed in App
and Patterns), well tube display and various other display attr
controls is discussed in the following sections.

Volume Outlines

When a faces file (.faces) is the selected file type, zone outline
outlines can be toggled on and off. Additionally, line color an
zone outlines of the faces file can be rendered.
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Z Contouring
pe, a Z Contouring section appears in the 
 the file with a color corresponding to the 
ing is done on a  by file basis, as controlled 

is applied. The text boxes and arrows 
d maximum Z values within which 
he slider bar turns Z color-filled contouring 
ome icon button resets any changes made 

al (the Interval text box), the color number 
d the number of colors to be skipped 

lor Palette icon button, which produces a 

t colors. For most properties this is a 
 scheme ranging from red to purple. Other 
be specified by selecting the next function, 
ors, discussed next.

cified color file from the file directory. A 
are also supplied with the Demo 3D 
.

82 EarthVision 6.0 2

When a faces file or scattered data file is the selected file ty
Render tab. The Z-Contouring option colors the top surfaces of
elevation (or depth) value of that point in space. The Z contour
by the respective icon buttons.

The slider bar displays the range over which the Z contouring 
beneath the slider bar can be used to change the minimum an
contouring is applied. Selecting the Color Bucket icon beneath t
on. The Color File icon button is used to change color files. The H
back to the defaults.

The controls beneath the slider bar control the contouring interv
at which the colored contours will start (the Start text box), an
between consecutive colors (the Step text box).

The colors used for Z contouring can be modified using the Co
pull-down menu containing the following options: 

 Load Default Colors  . . . . . . . . . . . . loads the defaul
“spectrum” color
color tables can 
Load Custom Col

 Load Color File  . . . . . . . . . . . . . . . . loads a user-spe
set of color files 
Viewer software
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Fault Face Color
r section appears on the Render tab. By 
 the Neutral Color Faults checkbox off 
 by the rest of the faces file (e.g., zone or 

ighlighted in the File Selection pane trans-
 be seen. Selecting the Transparency 
transparency, making the selected file 
ls, the faces file may, for example, hide 
he faces file and the wells to be seen.

tly active file render in wireframe mode. In 
hus allowing the user to see “inside” or 
hen multiple objects are displayed on the 

render a reservoir simulation grid to see 
3D Viewer EarthVision 6.0

When a 3D model (faces file) is displayed, a Fault Face Colo
default, fault faces are displayed in a neutral color. Checking
causes the fault faces to be colored in the same coloring used
property colors).

File Transparency
Checking the Transparency checkbox makes the file currently h
parent so that items such as a wellpath hidden by the file can
checkbox again, so that the check mark disappears, removes 
opaque. If a faces file is displayed together with multiple wel
some of the wells. Turning transparency on would allow both t

Wireframe Rendering
Checking the Wireframe Rendering checkbox makes the curren
this mode only the edges along certain polygons are visible, t
“through” the object in question. This can be extremely useful w
screen simultaneously. For example, the user could wireframe 
the streamline data “inside” it.
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Symbol Display

cted, the Symbol Display section appears 

splayed at each point location can be 
he Scale text box. By default, the scale is 
 to 2 would make the symbols twice as 
ld make them half as big. The arrow 
rease or decrease the scale factor.

ions are displayed either in their symbol 
le or as a default cube, unless the number 
al to or greater than the value set for the 
the Render tab in the Preferences window 
erences). All data locations may instead be 
 2 pixel point by turning Point Render 
on. The Scale Factor still applies to the 
e point can be made larger or smaller.

isplayed in a data file, the disks can be 
trike/dip symbols displayed by turning the 
84 EarthVision 6.0 2

When a scattered data, property data, or wellpath file is sele
on the Render tab. This section contains three functions:

 Scale . . . . . . . . . . . . . . . . . The size of the symbols di
scaled up or down using t
set to 1. Setting the value
large; a value of 0.5 wou
buttons can be used to inc

 Point (Pt) Render  . . . . . . . . By default, all data locat
shape as defined in the fi
of points displayed is equ
Point Rendering Count on 
(accessed via Edit –> Pref
displayed as a 2 pixel by
mode on via the icon butt
point render mode, thus th

 Strike/Dip . . . . . . . . . . . . . When dipping disks are d
changed to ellipses with s
Strike/Dip button on.
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Annotation File Display
g additional options appear in the Render 

 width attribute. The Annotation line width 
annotation file to make all the lines thicker 

ith its native colors—the ones that are 
is desirable to change these colors and 
is option and choose the color using the 

ey are purely a 2-dimensional data type. 
 within 3D space. This slider bar and the 
l coordinate location at which to display 
3D Viewer EarthVision 6.0

When an annotation file is the currently active file, the followin
tab.

Annotation Line Width Scale
All the lines and polygons within an annotation file have a line
scaling tool allows a global scale factor to be applied to the 
or thinner to suit the scale of the visualization.

File-specified Colors
If this option is enabled, then the annotation file is rendered w
specified within the file itself. There may be occasions when it 
render the file in a single, different color. To do this, disable th
color palette selector at the base of the File Selection list.

Annotation Z plane
Annotation files contain no vertical coordinate information—th
Even so, a vertical position must be provided to render the file
associated interface tools allow the user to specify the vertica
the annotation file.
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Data Line Display

ining a line or well ID is selected, the Line 
These sections contain the following 

 line or well ID are typically connected by 
urned on or off using the Lines checkbox.

 connecting data points with the same line 
. The default width is 1 pixel. The width 

 to 5 pixels wide.

lor (if field exists) for entire line, or use 
 color for each line segment.

 line ID or well ID, in a scattered data or 
ed at the top of each line by setting the 
y default, the labels are placed at the top 
the Reverse icon (the curved arrows) sets 
om of the wellpaths.

labels can be changed. By default, the 
t to a 12 point font. The size can be 
12, 14, 16, 18, 20, 24, or 32 point font 
 available on both Linux and Windows 
86 EarthVision 6.0 2

When a scattered data, property data, or wellpath file conta
Display and Label Posting sections appear on the Render tab. 
functions:

Line Display
 Lines . . . . . . . . . . . . . . . . . . Data points with the same

lines. These lines may be t

 Pixel (Px) . . . . . . . . . . . . . . The pixel width of the line
or well ID can be changed
can be changed to be up

 Point Color Segments. . . . . Use the solid fill or line co
corresponding data point

Label Posting
 Labels  . . . . . . . . . . . . . . . . . . . .Any attribute, such as

path file can be post
Labels checkbox on. B
of the line. Selecting 
the labels to the bott

 Size (Sz). . . . . . . . . . . . . . . . . . .The point size of the 
Size combo box is se
changed to a 8, 10, 
(not all font sizes are
systems).
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 Reverse Position of Labels . . . . .By default, when labels are turned on for display, they are 
placed at the top of each line. Selecting the Reverse icon (the 

he labels to the bottom of the wellpaths.

re listed. The selected field is labeled.

between the center of the symbol and the 
ecified in “number of characters” and is 
nt size.

tween the center of the symbol and the 
ecified in Z units. A positive value offsets 
ymbol; a negative value offsets the label 
3D Viewer EarthVision 6.0

curved arrows) sets t

 Field to Label  . . . . . . . . . . . . . .The fields in the file a

 Horizontal Offset  . . . . . . . . . . .The horizontal offset 
label. The offset is sp
proportional to the fo

 Z Offset . . . . . . . . . . . . . . . . . . .The vertical offset be
label. The offset is sp
the label above the s
below the symbol.

Tube Display
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When a scattered data, property data, or wellpath file containing a line or well ID is selected, the Tube 
Display section appears on the Render tab. The “tube” surrounds the line or wellpath, and may be set to 

 the file, or radii that vary based on a 
ctions:

p the Create Tubes dialogue window. 
wn above, tubes can be displayed on one 
aths, using either the Common ID or Well 

Each path can be given a set radius, and 
ifferent values. Alternatively, a field in the 
t the radius along the length of the tube. 
ius can be set to be proportional to a 
 such as porosity. In addition, the radii can 
 single factor, linearly within a range, or 
 a range. Once created the tubes can be 
idually via the Tube dialogue. They can 
l together, the ends can be capped, and 
n be affected by the Z exaggeration or 
ns in the Tube Display section (discussed 

ll tubes that have been created when the 
ns off the display of all tubes when the 
the display off does not “destroy” the 
 them.

es are created the ends are not covered; 
ath within the tubes. Setting the Cap icon 
r at the ends of every tube displayed.

 of the tube takes into account such things 
n and the XY versus Z units of the display. 
 of the tube always reflects the actual 
r the radii. Turning the Circular/Elliptical 
 displays the tubes as a circle (i.e., a 
 regardless of the Z exaggeration or 
ts. When this setting is on, Z exaggeration 
vertically; it is important to note that the 
s not reflect the actual radii numbers in all 
uld not be used if the tube is meant to 
asurement.

 drawn with 16 facets; allowable values 
 28, and 32. Larger numbers produce a 
 tube, while smaller numbers produce less 
88 EarthVision 6.0 2

have a single radius, radii that vary based on a radius field in
different field in the file. This section contains the following fun

 Create and Modify Tubes . . . . .The first icon brings u
Using this window, sho
or more lines or wellp
ID as the Tube Field. 
paths can be given d
file can be used to se
For example, the rad
property in the field,
be scaled either by a
logarithmically within
turned on or off indiv
also be turned off al
radius of the tube ca
not using the other ico
next).

 All icon . . . . . . . . . . . . . . . . . . . .The All icon turns on a
button is set on; it tur
button is off. Setting 
tubes; it merely hides

 Cap icon  . . . . . . . . . . . . . . . . . .By default, when tub
you can see the wellp
on puts a cap or cove

 Circular/Elliptical Tubes. . . . . . .By default, the shape
as the Z exaggeratio
In this way, the shape
numbers specified fo
Tubes icon off always
circular cross section)
differences in the uni
will stretch the tubes 
shape of the tube doe
cases. This setting sho
show some sort of me

 Tube Facets . . . . . . . . . . . . . . . .By default, tubes are
are 4, 8, 16, 20, 24,
more circular-looking
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circular tubes. There are speed and memory advantages to 
using smaller numbers. This is a global setting for all tubes, and 

e files (.vue) that are created.

display (.bwd) file. A binary well display 
display the log to either the left or right of 
 a BWD file is the active file in the Viewer, 
idth of the BWD track in the Viewer. In the 
3D Viewer EarthVision 6.0

gets saved to any vu

Binary Well Displays (BWDs)
An alternative way to display well logs is using a binary well 
file contains not only the well log values but the instructions to 
the well, together with color and scale information. Also, when
the Render tab will contain controls for adjusting the overall w

Well log tube width varies based on well log values
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following illustration, the green log appears to the left of the well and the red log appears to the right of 
the well. As the display is rotated, the logs remain in their proper locations relative to the well.
90 EarthVision 6.0 2
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Decimation Factor

 rendered by only drawing one of every N 

 line rendered objects by rendering only 
. The setting acts on any file which uses the 
 is set to 1, then every line-based object in 
ct line-based objects are rendered. For 
nd D. With the Line Decimation set to 1, all 
 only every 2nd well is rendered, starting 
 Line Decimation setting is 3 then wells A 

ndered. This visibility filtering can act to 
he cases of large files. 

 accept a line reading:
 header then the number following the 
 this file is loaded to the Demo 3D Viewer.
3D Viewer EarthVision 6.0

The Line Decimation Factor reduces the number of lines or wells
lines. 

The Line Decimation Factor acts to reduce the number of visible
every nth object (where n is the number given in the interface)
wellid, commonid, or lineid attribute. When the Line Decimation
the file is rendered. As the number is increased, then only sele
example, imagine the case of a file with four wellids A, B, C, a
four wells are rendered. If the Line Decimation is set to 2, then
with the first (namely wells A and C would be rendered). If the
and D are rendered, and with a setting of 4, only well A is re
significantly speed up rendering, and reduce visual clutter in t

Related to this, note that scattered data file headers can now
# Line_decimate_factor:. If this line is present in the file
parameters is used as the default line decimation factor when
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Spider Diagram Display
 pane, the Render tab contains a Spider 
er diagrams. This function flattens all wells 
is particularly useful with path files whose 
 with increasing Z. When this feature is 

d either on a plane or draped atop a 
n image registration file (.imreg) must 
). In the case of draping seismic attributes 
automatically; hence, in this case, the struc-
ge file or an image registration file is 
following controls for draping the selected 

ed either transparently or as a solid 
he Transparency checkbox, so that items 
 by the file can be seen.

ed horizontally at a particular Z elevation. 
x, and arrow buttons to position the Z 
le checkbox (so that a checkmark 
age.
92 EarthVision 6.0 2

When a line-oriented data file is selected in the File Selection
Diagram section, shown below, that controls the display of spid
to a single plane, and turns off the data symbols. This feature 
wells all generally start close to one another, and then diverge
enabled, all wells resemble spiders, as shown below.

Image Display
An image such as an aerial or satellite image can be displaye
structural surface. In order to drape an image on a structure, a
already exist (refer to Image Registration for more information
created from a SeisWorks database, the imreg file is created 
ture of the imreg file is of no concern to the user. When an ima
selected in the File Selection pane, the Render tab contains the 
image:

 File Transparency  . . . . . . . The image can be display
surface, as controlled by t
such as a wellpath hidden

 Image Z Plane . . . . . . . . . . The image can be display
Use the slider bar, text bo
plane, and select the Visib
appears) to display the im
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 Image Draping  . . . . . . . . . The image can be draped on one or more surfaces (2D grids or 
faces files). Use the tree to specify the surface on which the image is 

checkbox for the surface (so that a check-
the Drape All checkbox displays the image 
ces. If multiple images and multiple grids 
ify which image is displayed on which grid. 
extends beyond the image boundaries, 
xterior checkbox allows the surface colors 

ng surface extends beyond the image and 
 checked, the underlying surface is 
than in surface colors.
3D Viewer EarthVision 6.0

draped, by selecting the 
mark appears). Selecting 
on all the available surfa
are loaded, you can spec
If the underlying surface 
selecting the Transparent E
to be seen. If the underlyi
Transparent Exterior is not
displayed in gray rather 
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Edit Tab

le, to edit data fields in a scattered data 
pe selected in the File Selection pane. The 
ths file.
94 EarthVision 6.0 2

The Edit tab is used to edit and create items in files, for examp
file. The controls on the Edit tab vary depending on the file ty
following illustration shows the Edit tab as it exists for a wellpa
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Graphic Data Editor
a, property data, and well path data. The 
3D Viewer EarthVision 6.0

Graphic data editing is used to edit and display scattered dat
following features are available on the Edit tab on the Panel.
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Data Files
ontaining an x, y, and z-field can be 
tionally contain P-fields, as well as 

 active file, as shown in the Active Edit File 
iewer, the “active” file defaults to the file 
es can not be selected simultaneously for 

the viewer.

Select “filename” in Panel option.

ose between selecting data points in 
tion).

s shown in the Active Edit File box, so that 
s selected in the Model window. So if two 
he Active Edit File, the first file remains as 
ected, thus allowing the locations in the 
t file. Selecting the Lock icon button again 
96 EarthVision 6.0 2

In general, scattered data, property data, or well path files c
displayed and edited in the Demo 3D Viewer. The file can op
numerous other fields.

Active Edit File
Select and edit operations can be applied only to the currently
box on the Edit tab. If more than one data file is open in the v
highlighted in the File Selection pane on the Panel. Multiple fil
editing.

To Select a File for Editing
Do one of the following:

 Highlight the file in the File Selection tree.

 Select one of its data points using the pointer tool in 

 Click right mouse button on a data point and choose 

 Use the Cycle button on the File Query window to cho
multiple files (see File Query section for more informa

Lock the Edit File
Selecting the Lock icon button locks the currently active file, a
the Active Edit File can not be switched, regardless of what i
scattered data files are open, and the first file is locked as t
the active edit file even if a point within the second file is sel
second file to be used to guide the point additions in the firs
unlocks the file.
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Undo/Redo and Edit History
 a series of edits have been made, Undo 
e next most recent edit is reversed, and so 
t edit that was reversed by Undo.

The edits are listed in order numerically 
eral edits can be undone or redone in a 
t and choosing Undo, all the previous edits 
ing it, are undone. If new edits are made 

nd cannot be restored using Redo.

ed. When point(s) are selected the File 
he data point selected. (See the File Query 

ayed in the appropriate box on the Edit tab.

t click on a point.

wn the left mouse button. Lasso mode is 
ght-clicking on a data point and choosing 
s additional lasso selections to the current 
olding the + key while in Lasso mode. The 
ctions from the current set of selected 

y while in Lasso mode.
3D Viewer EarthVision 6.0

These commands are used to Undo or Redo recent edits. When
reverses the most recent edit first. If Undo is selected again, th
on. The Redo command can be used to repeat/remake the las

The Edit History pull-down menu contains a list of recent edits. 
with the highest numbered edit being the most recent one. Sev
single operation using Edit History. By selecting an edit in the lis
from the top of the list down to the selected edit, but not includ
in the Viewer after using Undo, these removed edits are lost a

Select Modes
In Select Mode individual or multiple data points can be select
Query window contains the name of the file and the values of t
section for more information).

Note: For data with line-id or well-id, this information is displ

To Select a Point Using the Pointer Tool
 Left-click on a point.

To Select Multiple Data Points
Do one of the following:

 Check the Multiple Select box on the Edit tab and lef

 Use Lasso to draw around data points by holding do
accessed via the Lasso button on the Edit tab or by ri
Select –> Lasso mode. The Lasso Plus icon button add
set of selected points; this mode is also selected by h
Lasso Minus icon button subtracts additional lasso sele
points; this mode is also selected by holding the - ke
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To Select a Line of Data Points

tion).

 the line.

se Select –> Select All Visible Points.

lected the last selection is white and the 
und is white selected points are colored 

enu.

d Invert. Clear will unselect all currently 
nt selections; all currently unselected points 
98 EarthVision 6.0 2

Do one of the following:

 Right-click and choose Select –> Select Entire Line.

 Use the Lasso function (see description in previous sec

 Double click on the line using left mouse button.

 Use Multiple Select and left-click on all data points in

To Select All Data Points
 Right-click on a point in the viewer window and choo

Selected points are colored light blue. If multiple points are se
previously selected points are light blue. If the viewer backgro
light grey and turn light blue as multiple points are selected. 

To Unselect a Point
 Left click on the selected point(s).

To Unselect All Points
Do One of the following:

 Use Clear button on the Edit menu or on File Query m

 Right-click and choose Select –> Clear Selections.

Select Operations
Two features are available under Select Operations; Clear an
selected points and lines in the viewer. Invert reverses the curre
are selected and vice versa.
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These two commands can also be accessed by right-clicking on a point and choosing Select –> Invert 
Selections and Select –> Clear Selections.

es, individual data points and lines of data 
etween two data points connected by a 

 Add and Insert commands points are 
 cursor documentation).

ly, edits are not saved to the data file 
file using File –> Save. Alternatively, the 
hen removing the file from the viewer or 

r at the desired location and click Add or 
ursor icon in upper left of the Model 

int, position the 3D cursor to location and 

be entered into the well-id box on the Edit 

ing steps:

 a line.

 to the line.

adjacent point.

/line-id fields are added to the file. If the 
 been set using the Edit Field Defaults 
mation.
3D Viewer EarthVision 6.0

Edit Operations
These operations are used for creating and modifying data fil
points. Add adds points to the data file. Insert inserts a point b
line; a line ID or well ID is required to use this feature. For the
added at the 3D cursor location (see details elsewhere for 3D

Note: Edits apply to the Active Edit File only. Most important
automatically. The user can force a save of the edited 
user is prompted to save an edited, yet unsaved, file, w
exiting the Demo 3D Viewer.

Add
 To add an individual data point, position the 3D curso

Ctrl+F (use keyboard shortcut, Ctrl+K, or select c
window to turn on the 3D cursor)

 To add a point to one end of a line, select the endpo
Add or Ctrl+F.

 To add points to a well path file a valid well-id must 
tab before the Add option is available.

Insert
Insert adds a point on a line between 2 points using the follow

 Using Multiple Select mode pick 2 adjacent points on

 Position the 3D cursor to the location to insert a point

 Click the Insert button or Ctrl+F.

 A line is drawn to the newly added point from each 

When adding or inserting points, only the X, Y, Z, P, and well-id
file contains other fields their value is null unless defaults have
command. See the Editing Field Defaults section for more infor
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Delete
.

 Delete Selected Point(s).

 or hot key or Edit Operations –> Delete 

hoose Select –> Select Entire Line and then 
ted Point(s) or double click on the line and 

er (left-click), position the 3D cursor to new 
oose Edit Operations –> Move Selected 

ble click, right-click and choose Select –> 
se Move, Ctrl+M or Edit Operations –> 

nt is moved to the 3D cursor location. All 
 their starting points in relation to the last 

ng along a surface or feature (2D grid, 

ata points.

se individual points will result.
100 EarthVision 6.0 2

 To delete a point, select point and Delete or Ctrl+D

 Right-click on a point and choose Edit Operations –>

 To delete multiple points, select points and use Delete
Selected Point(s).

 To delete a line, right-click on a point on the line and c
right-click and choose Edit Operations –> Delete Selec
then use any of the options listed above.

Move
 To move an individual point(s), select point in the view

location for point and click Move or right-click and ch
Point(s) or Ctrl+M.

 To move an entire line of data points, select line (dou
Select Entire Line, use Lasso), position 3D cursor and u
Move Selected Point(s).

Note: If multiple points are selected only the last selected poi
other selected points are moved the same distance from
selected point.

Digitize Mode
This command allows quick data point addition and line buildi
faces file, etc).

 Check Digitize mode and left-click in viewer to add d

 For line data, a well-id or line-id is required; otherwi
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File Query

, scattered data, faces file, 2D grid, 3D 
roducing a File Query list box, shown 
 dip azimuth for 2D grids or faces files, 
box contains the name of the Active Edit 
tes to the current selection (or last selected 
 selecting the Cycle icon button selects the 
. For example, imagine a vertical well in 
behind the other, and the user clicks on the 
 the left mouse button is clicked, the Demo 
n the Cycle button becomes active. 
 point and automatically selects the next 
point. To the right of the Cycle label is the 
3D Viewer EarthVision 6.0

The File Query attribute window is displayed when data (e.g.
grid, and cellular grid) is selected with the left mouse button, p
above, displaying data for the selected point, surface dip and
and options to edit the file’s default values. The filename text 
File. As data points are selected in the viewer, File Query upda
point). If the highlighted point is not exactly the desired point,
next closest data, also referred to as cycling through the data
plan view so that all the points on the well are stacked up one 
front-most point but actually wants one behind it. The first time
3D Viewer selects the object closest to the eyepoint; this is whe
Selecting the Cycle icon button deselects the currently-selected
point in the list, eventually cycling around to the first selected 
number of items through which the File Query is cycling.
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Multiple windows can be opened by using the Pushpin (located to the right of the filename text box) to 
lock the current attribute window. Additionally, attribute data can be copied into a clipboard or text 

ext box.

escribed below.

values (although edits are not saved until 

s displayed in the viewer and 3D objects 
 items. The filename will change in the text 
 the number of items through which the File 

b and the selected point(s) in the viewer.
102 EarthVision 6.0 2

editor program by using the icon to the left of the filename t

Each File Query window includes three informational tabs as d

Query
 Edit Table allows editing of the selected point’s data 

File –> Save is invoked).

 The Cycle function is active when more than one file i
overlap. Use this function to cycle through the selected
box as Cycle is used. To the right of the Cycle label is
Query is cycling.

 Clear will remove all attribute values on the Query ta

Info
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As shown in the illustration, the Info tab on the File Query window displays the file path, version, descrip-
tion, XY and Z units, projection, ellipsoid, elevation above MSL (mean sea level), MD vertical offset, 

in the file, and whether the data is 

ccessed by selecting the Edit Field Defaults 

es are assigned when new data points are 
ed with their corresponding values (except 
 here or left blank. 

point’s values as the defaults for a file. 

t have any default values to edit. Also note 
ndow.
3D Viewer EarthVision 6.0

number of data points, number of wellpaths, number of fields 
temporal. This information is not editable.

Edit Defaults

This is the third tab in the File Query window and can also be a
button on the Edit tab in the 3DV Panel.

The default field values for a file can be set so that these valu
added. Under Edit defaults, the current file’s data fields are list
for x, y, and z fields). Default values can be edited or entered

Grab Selected Point Values is used to apply the selected data 

Clear removes the current default values.

Note: Data files containing only x, y, and z data fields will no
that the units of the fields cannot be changed in this wi



002 Dynamic Graphics, Inc. All Rights Reserved.

Text File Editor

in tabular format for editing. Features 
g units, hiding fields, as well as, undo and 
ed and the viewer updated to reflect 

 tab are disabled. If edits are made 
 if those edits should be saved.
104 EarthVision 6.0 2

The Text File Editor button opens up the active edit data file 
include adding fields, adding lines, renaming fields, changin
redo commands. Once edits are complete the file can be sav
changes.

While the Text File Editor is open all other functions on the Edit
before opening the Editor, a pop-up message appears asking

Icons at the top from left to right are:
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Open File to Edit
w in which a file can be selected and 
ed and a new directory can be created in 
 as selecting the Open File to Edit button.

t File –> Save As to save the edits to a file 
ave has the same effect as selecting the 

 in the Model window with the edits made 
ame function.

lank line into the file after the currently 

w blank line into the file before the 
cells.
3D Viewer EarthVision 6.0

Selecting the Open File to Edit button produces a Files windo
opened for editing. Also, the current directory can be chang
the Files window. Selecting File –> Open has the same effect

Save File
Selecting the Save File button saves the edits to the file. Selec
name different from that of the input file. Selecting File –> S
Save File button. 

Save File and Update Viewer
Selecting the Update Viewer button updates the data display
in this editor. Selecting File –> Update Viewer produces the s

Add Line after Selected Line
Selecting the Add Line after Selected Line button puts a new b
selected line. Data can then be entered in the new cells. 

Insert Line before Selected Line
Selecting the Insert Line before Selected Line button puts a ne
currently selected line. Data can then be entered in the new 
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Delete Selected Line(s)
 line from the file.

 file, at the end of the record. The new 
e file (e.g., if the file originally has 3 fields 
ld4 and field5). 

ently selected field from the data file.

 selected field(s) from the Data Fields 
ins in the file but simply is not displayed. 
 number of fields and the last field in the 
r window narrower, so that the last field is 

to the right. 
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Selecting the Delete Selected Line button deletes the selected

Add Field to File
Selecting the Add Field to File button adds a new field to the
field is named field# where # is the number of the field in th
and two new fields are added, the new fields are named fie

Delete Selected Field(s)
Selecting the Delete Selected Field(s) button removes the curr

Hide Selected Field(s)
Selecting the Hide Selected Field(s) button hides the currently
Editor window. The field is not removed from the file; it rema
This function is helpful when the file being edited has a large
file must be edited. Hiding fields makes the Data Fields Edito
easily viewed without needing to use the scroll bar to move 
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Make All Fields Visible
, even those previously hidden, in the Data 

history is contained in the Text File Editor.

ighlighting the cells to paste to while 
and columns can be copied and pasted in 

fault field names appears and allows a 
der will also display the available default 

the cursor on a row or column line until the 
 row or column.

 currently being edited. 

specified file name. 

 in the Model window with the edits made 
 Update Viewer icon button produces the 

r. If the edits have not yet been saved, an 
hether to save the edits before exiting the 
3D Viewer EarthVision 6.0

Selecting the Make All Fields Visible button displays all fields
Fields Editor window.

Note: Undo and Redo only work on the last change. No edit 

A single cell can be copied and pasted into multiple cells by h
holding down the left mouse button. In addition, multiple cells 
the same manner as long as units match for the fields.

By double-clicking on a column header, a drop-down list of de
user to choose a default or type in a field name. The Units hea
names by double-clicking on it.

Row height and column width can be manipulated by holding 
double-arrow icon appears; moving the cursor will modify the

File Pull-Down Menu
The File pull-down menu contains the following: 

• Open (Ctrl + O). . . . . . . . Opens a file for editing. 

• Save (Ctrl + S) . . . . . . . . Saves the edits to the file

• Save As . . . . . . . . . . . . . . . Saves the edits to a user-

• Update Viewer . . . . . . . . . . Updates the data display
in this editor. Selecting the
same function.

• Exit (Ctrl + Q) . . . . . . . . . Exits the Data Fields Edito
inquiry is issued asking w
editor.
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Edit Pull-Down Menu

e file to data (real-world) coordinates.  To 

emo 3D Viewer., due to limitations of the 

hted) item(s) from the file. The selected item could 
 of items, or a group of rows and columns of items

) into the file at the selected point

 selected line

tly selected line

e file

ected field and record (known as a cell) to the 

the file

 file

 previously hidden
108 EarthVision 6.0 2

The Edit pull-down menu contains the following: 

Image Registration
The Image Registration functionality is used to register an imag
initiate the image registration process, follow these steps:

• Load a 3D model into the Viewer

• Load an existing image registration file

An existing image registration file can not be modified in the D
Demo program.

Cut (Ctrl + x) Cuts or removes the selected (i.e., highlig
be a single item, an entire row or column

Copy (Ctrl + c) Copies the selected item(s) from the file

Paste (Ctrl + v) Pastes the previously cut or copied item(s

Undo (Ctrl + z) Un-does previous edit(s), one at a time

Redo (Ctrl + y) Re-executes previous edits, one at a time

Copy Line Copies a line or record

Add Line Adds a new blank line after the currently

Insert Line Inserts a new blank line before the curren

Delete Line Deletes the currently-selected line from th

Copy Field (Ctrl + c) Copies the data value in the currently sel
clipboard so that it can then be pasted.

Add Field Adds a new field to the file

Delete Field Deletes the currently-selected field from 

Rename Field Renames the currently-selected field

Hide Field Hides the currently-selected field(s) in the

Show All Fields Shows all the fields in the file, even those
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Appendix A: Screen Annotation Fonts
n a Demo 3D Viewer screen. These annota-
graphic display window, unlike surface 
f the ASCII data or faces file.

urier New, Helvetica, Century Schoolbook, 
supported point sizes are from 8 to 32).
3D Viewer EarthVision 6.0

Screen annotation displays text, lines, rectangles, and circles o
tion objects are positioned relative to the X,Y locations of the 
annotation, which are displayed relative to the X,Y locations o

This appendix shows samples of the available fonts: Arial, Co
and Times New Roman. Sample point sizes are also included (

Sample Fonts

Arial
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Courier
urier

urier-Bold

urier-Oblique

urier-BoldOblique
110 EarthVision 6.0 2

ABCDEFGHIJKLMNOPQRSTUVWXYZ Co
abcdefghijklmnopqrstuvwxyz
0123456789

ABCDEFGHIJKLMNOPQRSTUVWXYZ Co
abcdefghijklmnopqrstuvwxyz
0123456789

ABCDEFGHIJKLMNOPQRSTUVWXYZ Co
abcdefghijklmnopqrstuvwxyz
0123456789

ABCDEFGHIJKLMNOPQRSTUVWXYZ Co
abcdefghijklmnopqrstuvwxyz
0123456789

Century Schoolbook
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Times New Roman

t

int
oint
3D Viewer EarthVision 6.0

Sample Point Sizes

Letter Size Point Size

ABCD 8 point

ABCD 10 point

ABCD 12 point

ABCD 14 point

ABCD 18 poin

ABCD 24 po
ABCD 32 p
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Appendix B: Hot Keys
o quickly perform a command. They allow 
 menu, to move from menu to menu without 
out the menus showing. Hot keys are 
 the right of each menu item that has a hot 

 and number combination, or a control 
 HOME key or the F1 key), or control 
^1) invokes the command the same way as 
when the key is pressed, and does not 
e hot keys are typed using the control or 

s shown in the program and in the 
is designated by Alt.

der. The functions associated with each hot 
m widget.
112 EarthVision 6.0 2

“Hot keys” are one-key or two-key strokes available in order t
users to perform commands without moving to the appropriate
selecting the Main Menu, and to work in full-screen mode with
displayed on the Demo 3D Viewer menus in a recessed box to
key.

Each hot key is represented by a single letter, number, a letter
character. Typing the letter, number, specified key (such as the
sequence (e.g., the Ctrl key and the number 1, indicated as 
would clicking on the menu button. The command takes effect 
require the return or enter key to be pressed. All two-strok
alternate key simultaneously with another key. The Ctrl key i
documentation using the caret sign (^), and the alternate key 

The hot keys are grouped and listed in approximately menu or
key are discussed in the sections regarding the related progra
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Appendix C: Demo 3D Viewer Glossary
ment.

ing system which is readily displayed as 
ystem. ASCII files can be called plain text 

s much less space than ASCII files, and can 
 grids are all written in binary, for 

rid nodes that are specified in the grid 
ecause they are “clipped” by one or more 
, or P grid-ranges, the top or bottom 2D 
al gridding, or any null or invalid values in 
splayed in the Demo 3D Viewer; however, 

wer. It contains information regarding the 
ctive colors (known as the Color Table), the 
nd the location of the X, Y, and Z slices. 

tinguish the different isovalue shells, zones, 
3D Viewer EarthVision 6.0

This glossary covers terms referred to in The Demo 3D Viewer docu

ASCII File
An ASCII file is stored using a standard internal computer cod
characters on a terminal or sent to a printer on the computer s
files.

Binary File
Binary Files are stored in an internal coding system, which use
be read or written more quickly. Faces files, 2D grids, and 3D
example.

Clipped Data
Clipped data includes any scattered data points or 2D slice g
calculation, but are not actually used for calculating the grid b
of the gridding parameters. Clipping can be due to the X, Y, Z
structure grids, the polygon file, transformation during conform
the data set or 2D slice grid. These data are not generally di
they can be, if desired.

Color Key
The Color Key is the legend box displayed in the Demo 3D Vie
current display, such as the isosurface intervals and their respe
orientation of the axes, the Z-exaggeration, viewing angles, a

Color Table
The Color Table is used to refer to the series of colors that dis
or Z-levels.
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Control Information
odify an output 3D property model or its 
le, come from additional boreholes for a 
ic or atmospheric information. The 
he Demo 3D Viewer. This new edited infor-
l. (Additional editing capabilities are 

 model, showing a single surface in space 
ces file is input to the Demo 3D Viewer for 
e shells) and rotation. Refer to Chapter 2: 

faces within a faces file. 

being typed. They eliminate the need to 

ample, an isovalue line is made up of 
.

 one isovalue shell and the next higher or 
 not be uniform within the 3D model. Isosur-

e below). The isovalue level may be 
d isovalue interval. 
116 EarthVision 6.0 2

Control Information is any type of data that can be used to m
associated input scattered data file. The data may, for examp
seismic data set, previous or new studies, or additional geolog
additional data can be used to edit the scattered data file in t
mation can then be used for recalculation of the 3D grid mode
available in EarthVision.)

Faces
A Faces File is the graphic file calculated from a 2D or 3D grid
or modeled property values at user-specified isovalues. The fa
manipulation (e.g., slicing into the model and removing isovalu
3D Viewer File Types.

Facets
Facets are the polygons that create the displayed isovalue sur

Hot Keys
Hot Keys perform certain display functions immediately upon 
use the mouse for selecting menu items.

Isovalue
Isovalue is defined as having the same numerical value. For ex
points that all have the same numerical value assigned to them

Isovalue Interval
The Isovalue Interval is the difference in P-value units between
lower shell. The interval is chosen by the user and may or may
face Interval is used synonymously with Isovalue Interval.

Isovalue Level
The Isovalue Level defines the P-value of the isovalue shell (se
defined explicitly by the user or determined by a user-specifie
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Isovalue Shell
3D grid that have the same value of P. It is 
re Isovalue Surface, Isovalue Layers, and 

 modeled in a 3D grid. Associated with 
ridding 3D models must contain an X, Y, Z, 

tion. P-values are the input used for 

 model.

remove a portion (or volume) of the model 
 direction) and the full range of the model 

 this would be a “Y-slice”). A new Y-plane, 
face in the display. The illustration below 
3D Viewer EarthVision 6.0

An Isovalue Shell is a surface boundary joining points within a 
the three-dimensional equivalent to a contour line. Synonyms a
Isosurface.

Isosurface (See Isovalue Shell)
Isosurface Interval (See Isovalue Interval)
Isosurface (Isovalue Level)

P
“P” is the variable name used to stand for the property being
each P is an X,Y,Z location. Every scattered data file used for g
and P field, although the names may vary.

P-value
P-value is the value of the property at a particular X,Y,Z loca
gridding and also represent the grid node value. 

Property Model (See 3D Grid Model)
Shell (See Isovalue Shell)
Slice

A Slice refers to a method of manipulating the display of a 3D

Slice (verb): To take a “slice” in the Demo 3D Viewer means to 
that is often one grid cell in thickness in one direction (say the Y
in the other two directions of the axes (the X and Z directions;
which was previously interior to the model, is now an exterior 
shows a Y-slice.
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mation. It can also include multiple P-fields 
zimuth, feature number, time, or symbols 
Viewer File Types. Scattered data files can 
essing.

tions for the proper display of faces files, 
h names ending in .vue control the display 
ASCII scattered data files.

xis. In other words, every grid node within 
 Every X slice is along an X-column.

n other words, every grid node within that 
y Y slice is along a Y-row.

In other words, every grid node within that 
ry Z slice is along a Z-level.
118 EarthVision 6.0 2

Scattered Data File
A Scattered Data File contains, at a minimum, X, Y, and Z infor
and special fields such as a line identifier, line color, dip, dip a
fields. The special field names are described in Chapter 2: 3D 
be displayed in the Demo 3D Viewer without any kind of proc

Vue Files
Vue Files are ASCII files that contain Demo 3D Viewer specifica
ASCII scattered data files, or 2D or 3D grid files. Vue files wit
of faces files, and those ending in .dvue control the display of 

X-column
An X-column is a plane of grid nodes perpendicular to the X-a
that plane has the same X-value, but different Y and Z values.

Y-row
A Y-row is a plane of grid nodes perpendicular to the Y-axis. I
plane has the same Y-value, but different X and Z values. Ever

Z-level
A Z-level is a plane of grid nodes perpendicular to the Z-axis. 
plane has the same Z-value, but different X and Y values. Eve

X

Z
Y

Y-slice
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